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1 ChemFlux Introduction

We would like to welcome your use of the ChemFlux contaminant transport modeling software. ChemFlux is
a sophisticated modeling tool that implements automatic mesh refinement in order to solve complex models
with increased accuracy. Combining an easy-to-use graphical user interface, a sophisticated finite element
solver making use of automatic mesh refinement, and a 2D/3D visualization package, ChemFlux allows
geotechnical engineers, soil scientists and hydrogeologists to solve a wide variety of models common to
industry practice. Our software is constantly maintained by a team of world-class programmers, physicists,
geological and geotechnical engineers in order to provide a cutting edge product.

ChemFlux is currently being used by the majority of major geological/hydrological consulting firms and has
been subjected to professional peer review.

FEATURES

The following features distinguish ChemFlux from other numerical modeling packages. While there are
hundreds of smaller features which distinguish our software we feel the following primary features make our
software package unique:

o Fully automatic mesh refinement in 2D and 3D

o Ability to have mesh refinement "“follow" a contaminant front

o 3D tetrahedral automatic mesh generation

e Customizable finite element solution using mathematical scripting language
o Fully automatic time-step determination for transient models

A list of detailed features of the software may be found here.

APPLICATIONS

Implementation of the numerical modeling framework allows solutions to be generated for the following types
of models:

Salt movement in the potash industry

Migration of pollutants out of landfills
Movement of solution in heap leach operations
e Movement of contaminants out of canal systems

Other examples of the use of ChemFlux to solve specific models may be found here.

We have worked hard to minimize the complexity normally associated with numerical modeling. It is our
sincere hope that your use of our software will be a pleasant one. | would welcome any comments and
suggestions you may have.

Best regards,
Murray Fredlund, PEng, PhD

President/CEO
SoilVision Systems Ltd.
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2 Getting Started

This chapter provides information for quickly getting started with CHEMFLUX.

2.1 About Documentation

Documentation for CHEMFLUX consists of four separate manuals: this User’s Manual, the Tutorial Manual,
Theory Manual, and the Verification Manual. The Tutorial Manual guides the user through standard example
models detailing how to define and solve a model. Modeling tips are also provided. The manuals are designed
such that the user may become familiar with the basics of using CHEMFLUX and allow them to begin
creating their own models quickly. In the Theory Manual, the technical aspects of CHEMFLUX, its soil
models, boundary conditions, and other elements are presented. The description of a number of worked
models makes up the Verification Manual. The models have been solved using CHEMFLUX and the results
have been compared to documented research publications and results from other software packages.

The features and capabilities of CHEMFLUX are described in the User’s Manual. This description includes
details on how to set up the model geometry, define soil properties, apply boundary conditions, and plot
computed results.

Tips are provided throughout this manual offering suggestions on model definition,
quick ways to perform certain operations, and other useful or interesting modeling
Tip! information.

2.2 Basic Windows Skills

The following sections will provide the user with simplistic directions on Windows functionality as it relates
to CHEMFLUX.

2.2.1 Windows Fundamentals

CHEMFLUX adopts many of the standards that have been implemented with Windows. The CHEMFLUX
interface consists of the main workspace and many other dialogs that can be opened by clicking buttons,
selection from the menu, or other actions. One of the standards in Windows is to provide the user with a “tool
tip” for every command button. CHEMFLUX has also adopted this standard. The tool tip is accessible by
holding the mouse over the command button for a few seconds. A “tool tip” will appear giving a description
for the command button.

It is also standard to duplicate all of the command buttons with an option in a drop down menu. The
descriptions that appear in the “tool tip” will be the same as the description used in the menus to allow the
users to easily match command buttons and its equivalent menu option.

It should also be noted that the toolbar icons will also be shown beside their related command within the menu
structure.

2.2.2 Copy and Paste

Data from external sources such as spreadsheets, text documents, and other SoilVision software can be pasted
into CHEMFLUX in one of several ways. Any single number or text can be pasted into a single field in most
dialogs. For example, the soil description ‘Floral Till” could be pasted directly into the Soil Description field
on the Soil Properties dialog. Select the text in the text editor and press Ctrl + C on the keyboard. Then select
the destination field in CHEMFLUX and press Ctrl + V on the keyboard. Similarly, the value 0.04 could be
copied from a single cell in a spreadsheet application and pasted into the field Mesh Spacing on the Region
Properties dialog.
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CHEMFLUX allows the copying and pasting of columns of data directly into certain dialogs. This action

increases the speed at which models can be created. Instructions for pasting into these dialogs are located in
the corresponding sections.
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3 Use of Engineering Judgment

The results of a CHEMFLUX analysis should not be applied to an engineering design without first being
filtered through professional engineering judgment. It has been a priority at SoilVision Systems Ltd. to
benchmark the results produced by CHEMFLUX against solutions that are well known. The results of these
comparisons may be found in the verification manual included with the CHEMFLUX software.

It is recommended that the simple-to-complex methodology be applied when solving a particular problem with
SVDYNAMIC. The simple-to-complex approach involves beginning all modeling projects with a simple
representation of the physical system that can be verified using hand calculations. A variety of further
complexities can then be added to the model while the user carefully observes the change in results created by
added level of complexity. The reasonableness of changes in the computed results must be subjected to
professional engineering judgement.
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4 FAQ ChemFlux

The following frequently asked questions (FAQ) represent typical questions that we encounter from our user
base.

Q: The FlexPDE output files are getting large and | am getting an "Out of disk space" error. What should | do?

A: Any plots designated in the Plot Manager which are specified as a PLOT are stored in the PG5 output file.
Change as many plots as you can to be MONITORS - which are not stored.

Q: What is a reasonable number of time-steps to output to an AcuMesh DAT file in a transient 3D analysis?

A: Visualization time and disk space become issues when reporting results for large 3D transient models. It is
recommended that not more than 20 time-steps are output for large 3D models.
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5 Historical Development

The first version of ChemFlux was released in May of 2002. The application of the FlexPDE solver to the
solution of fate and transport was a research project conducted by SoilVision Systems Ltd. The culmination
of the SoilVision Systems Ltd. research project resulted in the ChemFlux software, which writes the
mathematical descriptor necessary for the solution of fate and transport models.

The FlexPDE generic finite element solver was developed by PDE Solutions of Antioch, CA. The original
work on the generic solver began over 31 years ago. Since that time the software has been developed and
maintained by Bob Nelson of PDE Solutions. The FlexPDE solver continues to be a world leader in the
solution of partial differential equations by the finite element method.



SOILVISION SYSTEMS, LTD. The Workspace 12 of 108

6 The Workspace

The workspace of the software is the area which presents the drawing CAD window as well as the buttons and
menus allowing access to the primary functionality of the software. It is through this interface that the user will
primarily interact with the software. The following sections outline details related to using the CHEMFLUX
user interface effectively.

6.1 Workspace Sections

The workspace is divided into five main sections. Each of these sections will be discussed in the following
sections.

# SYFlux PROFESSIONAL -- [C:\SUSWModel FilesiExamplesi3DiSteadyStateXPstr011Pstr01.svm] - 3D
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6.1.1 Title Bar

The title bar is used to display the project and problem that are currently open. The title bar will also indicate
the current authorization level of the software: Student, or Full.

6.1.2 Menu Bar

The menu system for CHEMFLUX is designed to be firstly intuitive to the end user and secondly it is
designed to guide the user through the logical progression of model creation and solution. In general the menu
system is designed around a logical left-to-right and top-to-bottom progression. In other words, if a user
progresses through the menu options in a left-to-right and a top-to-bottom manner they will automatically be
guided through the logical steps of model creation.
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6.1.3 Toolbars

Command buttons are located on the floating toolbars which are newly implemented in SVOffice 2006. A
description of the purpose of each toolbar button may be obtained by moving the mouse over the button.
Additional description related to the toolbar will then appear as a tool-tip.

The following toolbars are available:

File:

[<]

Viesw

[<]

Regions & Surfaces

Drawing Geometry
Drawing Arbworks
Applicaton Selector

VView Seleckor

[ L]

Toolbars may be displayed or hidden through the View > Toolbars menu.

6.1.4 Drawing Space

The drawing space is comprised of the CAD control used to present various 1D, 2D, and 3D views of model
design. All editing of the numerical model may be done using graphical drawing commands in the drawing
space. Objects represented in the drawing space are either graphical artwork (which do not affect model
output), or model geometries which are directly used in model creation. Double-clicking on any particular
graphical object will open the Properties dialog associated with that particular graphical object.

CHEMFLUX provides the ability to describe geologic features as they naturally occur. Regions and other
objects can be drawn in the two-dimensional/axisymmetric drawing space in cross-sectional view. The plan
view system operates as a 2D or Axisymmetric analysis except that regions and objects are drawn in plan view.
In 3D models, regions, surfaces, and layers organize the problem. In the 2D view of the three-dimensional
drawing space, regions and other objects are drawn in plan view. The 3D Model section includes a discussion
on how each of the components relates to one another.

The drawing space is the area where geometry is added, edited, and displayed, as well as where other objects
such as features, water tables, and illustration objects are viewed. The main features of the drawing space are
the grid, limits, and view. The Workspace grid may be edited by changing the spacing between grid points or
turning it on and off. The grid spacing is controlled from the Workspace Grid Button located on the View
toolbar, while the Workspace grid is turned on and off with the GRID option in the status bar.

The limits of the drawing space are set using the View Settings dialog, located in the View > Settings menu.
When an object is selected in the drawing space the Region Selector is updated to show you the region that
you have selected. In three-dimensional problems the surface selector always displays the active surface.

6.1.4.1 Workspace Object Hierarchy

CHEMFLUX has an established hierarchy for displaying objects in the drawing space. Objects higher in the
list will appear over top of objects that are lower. The hierarchy is as follows:

1. Sketching text and lines (top layer)
2. Boundary condition graphics
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3. Flux sections

4. Features

5. Regions (order specified by region ID - if B.C. graphics are ON, the region geometry does not need
to show)

6.1.5 Status Bar

The status bar consists of controls that aid in drawing and viewing objects in the workspace. The current
coordinates of the mouse icon are also displayed. The status bar settings allow the user access to CAD drawing
functions which can greatly simplify the input of model geometry. The command settings may be changed by
clicking on the status bar. The drawing settings are also available from the View > Options dialog under the
Grid tab.
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7 Tutorial Models

Tutorial example models for CHEMFLUX can be found in the separate Tutorial Manual. The Tutorial Manual
for each software package can be found under the Help menu for each respective package.
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8 General Modeling Concepts

The purpose of this chapter of the user's manual is to provide the user with a general idea of the numerical
modeling concepts associated with the operation of the sophisticated CHEMFLUX software package. The
software is designed to be easy to use once general concepts are understood. Concepts such as the input of 2D
or 3D geometry, minimum modeling requirements, and the creation of plan view or axisymmetric models are
covered in this chapter.

A 2D or 3D model is created using the following building blocks:

e Region: Similar to layers in AutoCAD. Each region may have multiple shapes or features associated
with it. Soil properties are applied to regions and therefore apply to all shapes within a region.

e Shapes: Basic geometric building blocks which include closed polygons or circles. Only contain x and
y coordinates. In 3D, shapes extrude vertically through surfaces to define specific model blocks.

e Features: Polylines which may be drawn internal to region shapes. Used to force nodes or cells along
internal lines, force 3D "creases”, or specify internal boundary conditions. Features extrude to planes in
3D.

o Surfaces: Basic building blocks of a 3D numerical model. 3D models are defined by a series of
stacking surfaces. Each surface may be specified by a grid, an expression, or a constant. Specific
modeling "blocks" are defined by the projection of region shapes onto surfaces.

e Layers: Formed by surfaces on the top and bottom.

The interaction between the various objects may be seen in the following diagram:

Material
Properties

»  Regions

Shape 1

»  Shape2

b Shape 3

Surfaces and layers are "added to the mix" in the definition of a 3D model.

Layers

Surface 2

4 Surface L
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8.1  Minimum Requirements

CHEMFLUX requires certain information to be provided before a model can be sent to the solver. This
chapter summarizes the information that is required by CHEMFLUX to successfully solve a model.

e Regions
Every model requires at least one region. For a region to be included in the analysis, CHEMFLUX
requires a valid soil to be specified for that region. The requirements for a valid soil are discussed below.

e Surfaces
Every three-dimensional model requires at least one layer. To describe a layer to CHEMFLUX you must
include one region on at least two surfaces. Again a valid soil must be specified for each region to be
included in the model. Failure to provide a soil will cause the region to be void over the layer it resides
on.

CHEMFLUX provides one region and two surfaces to each new model by default.
CHEMFLUX does not allow you to delete any of these entries, as they are the
Tip! minimum requirements for any model.

e Elevations
An elevation is required for every grid point that exists on a surface.

e Saturated Hydraulic Conductivity
Every soil that is entered into SVFLUX must have a Saturated Hydraulic Conductivity, k... This becomes
the hydraulic conductivity of the soil throughout the saturated regions or the model.

e Soil Water Characteristic Curve
For Transient-State modeling SVFLUX requires a Soil Water Characteristic Curve. The derivative of this
curve is used to describe the storage function of the soil.

8.2 2D Model

A 2D model is viewed in cross-section and is considered to have a unit width into the workspace. In the 2D
model a region can have multiple geometric shapes. There will be one Dominant Shape and any number of
lesser shapes. The lesser shapes can be defined inside of the dominant shape. The lesser shapes would then
result in void areas or “cut-outs” of the dominant shape. Mesh will not be generated for the void or "cutout"
shapes. Boundary conditions can be assigned to the edges of the internal void shapes.
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Dominant Shape

N
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, . +
{ vy

Cut Out Shapes

=

8.3 3D Model

In a 3D model the workspace may be set to a 2D plan view or a full 3D view. Regions in the workspace
behave in the same manner as a 2D model. The primary difference is that only a single region shape can be
drawn on a 3D region. A 3D model consists of layers that are bounded by surfaces. Surfaces are defined as a
grid with an elevation at each grid point. Regions act as extrusions through all the layers of a problem. A layer
volume that is enclosed by a region will have a set of soil properties assigned to it or can be left as a void
space.

Boundary conditions can be assigned to any region segment on any surface or any surface area bounded by a
region. It is also worth noting that boundary conditions can be defined on the internal sidewalls of a 3D
model.

This simple three-dimensional example diagram will be used to illustrate the 3D model in more detail.
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Region 3

Region 1 Layera
Suﬂa"eA
SoilA Layer3
. Layer2
SoilB
| soiB et
SailC \ Layer1
SoilD
\ S\“‘a‘.'e'\
T SoilA /
e 3D Regions

Each 3D region can have one or more geometry shapes consisting of polygons or circles. The regions and
shapes are used to describe the problem in plan view. Each region shape is extruded through all the layers
in the problem. In the above problem there are three regions, 2 polygon regions (in this case they happen
to be rectangles) and a circle shape. In most cases the number of regions will depend on the number of
different soils encountered in the problem. When drawing a region shape in the drawing space, it is added
to the Region current in the Region Selector.

Surfaces

Surfaces are used to define upper and lower boundaries of layers. In the above illustration it can be seen
that there are five surfaces. Surface 1 describes the bottom of Layer 1, Surface 2 will describe the top of
Layer 1 and the bottom of Layer 2, and Surface 3 will describe the top of Layer 2 and so on. Every 3D
problem must contain a minimum of 2 surfaces. Note that the trace of every region will appear on all
surfaces. Therefore the circular Region 3 extends through all the layers, as well the Region 2 trace is on
surface 5 even though layer 4 is void for Region 2 in this diagram. Similarly, in the illustration below there
are 3 regions and their traces can be seen on the 3 surfaces.

It should be noted that the user may specify that a region not extrude through a particular layer through the
use of limited regions.
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e Surface Grids
Each surface consists of a grid of elevation values. The density of the X and Y gridlines will control the
accuracy of the surface definition, as an elevation must be provided for every surface grid point.
CHEMFLUX offers the flexibility of regular and irregular surface gridlines in both directions. This feature
allows the opportunity to define areas of interest in more detail. The CHEMFLUX solver uses the bilinear
method to interpolate between the points defined in the grid during problem solution.

Surface grids of varying sizes may also be used. For example, Surface 1 could have a 100m by 80m grid,
Surface 2 a 25m by 30m grid, and Surface 3 a 50m by 50m grid. The diagram below is a simple example
of grid of different sizes, but having the same number of grid points. Surface grids must be rectangular and
must have a defined elevation at every intersection point.

K If the problem contains grids of various sizes Pinching Out Surfaces may be
required.
Tip!

e Layers
A Layer is the area between two surfaces. Since there are 5 surfaces in the example illustration there are 4
layers in the problem.
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Pinching Out Surfaces

Surface 4

Surface 3

- 1
il
= i

If surface grids do not have the same dimensions it may be necessary to pinch out one surface at the edge
of another. In most cases, this will occur when you are trying to add a small feature onto a larger one, say
a dam sitting in a valley. From the above figure it can be seen that the grid describing Surface 3 will be
much larger than the grid describing Surface 4. The overall problem domain will automatically default to
the largest surface grid, in this case Surface 3. The grid for Surface 4 fails to describe the surface over the
entire domain of the problem; therefore, Surface 4 must be pinched out where it contacts Surface 3. This
will cause Surface 4 to default to the shape of Surface 3, everywhere that Surface 4 is not described in the
domain of the problem. Note that a pinch out surface may be a surface above or below the surface under
consideration.

Pinching out of sufaces is a difficult feature to accommaodate in a finite element solver and should be used
with caution. It is recommended that surfaces only pinch out at region boundaries. Surfaces which
randomly cross each other in 3D space will likely lead to tangled mesh errors. A workaround for this case
may be the use of a specified minimum layer thickness.

Assigning Soils

Each region-layer combination in the 3D model can be assigned a different soil. In the example there are 3
regions and 4 layers and thus 12 region-layer combinations. Each combination may either have a soil
assigned or be set as void. A void space is essentially air space. In the example Region 3 has been set as
void for all layers so there is a circular hole through the entire problem. Layer 1 and Layer 3 have each
been defined as a separate soil on region 1 and region 2. In Layer 2, Region 1 has been assigned Soil C
and Region 2 has been assigned Soil D. Finally, for Layer 4, Region 1 has been assigned the same Soil A
as Layer 1 and Region 2 is void.

8.4 Plan Model

In the Plan model the view is a plan view and a unit depth is assumed into the workspace. As in the 2D model
a region can have multiple geometric shapes in plan analysis. As well different regions will describe areas of
different soil properties.
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Dominant Shape 1
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8.5 Axisymmetric Model

With the Axisymmetric model a 2D cross-section is viewed. The R=0 coordinate becomes the rotational axis
for the model. As in the 2D model a region can have multiple geometric shapes in Axisymmetric analysis.
Different regions will describe areas of different soil properties. There is very little visual difference between
an Axisymmetric and a 2D model. The primary difference is in the method of formulation for the
Axisymmetric model. A regular 2D model is formulated under the assumption that the model is of one unit of
depth throughout the model domain. The axisymmetrical formulation includes a radius coordinate that
simulates a wedge shaped model. It is assumed that in an Axisymmetric model that the model depth is one
degree (out of 360 degrees) at any given point.

R =0

Liner

Water Table
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9 Menu System

The menu system for CHEMFLUX is designed to be: first, intuitive to the end user and second, to guide the
user through the logical progression of model creation and solution. In general the menu system is designed
around a logical left-to-right and top-to-bottom progression. In other words, if a user progresses through the
menu options in a left-to-right and a top-to-bottom manner they will automatically be guided through the
logical steps of model creation.

9.1 File Menu

The following operations are available for files in CHEMFLUX. The SVOffice 2006 software maintains the
traditional folder structure found in previous versions of the software. The following functions are provided in
the software for saving, opening, exporting, and printing models.

More information on file storage can be found under the Help system contained with the SVOffice Manager
dialog.

Description of specific functions is as follows.
Recent Files: Provides a list of the most recently opened models.
Exit: Closes the current model and exits the program.

9.1.1 Open/Close/Save
Model data in CHEMFLUX is stored in XML text files which may be opened by the user for viewing.

Open: The open command opens a new XML model file. Files are tagged with a .SVM file
extension. Only one model can be opened at a time. Double-clicking on a file from within
Windows Explorer will automatically start the SVOffice application and load the
designated model.

SVOffice Manager: This command opens the Manager dialog which is the primary method of performing
file operations in the context of the modeling software. The SVOffice Manager loosely
enforces the established directory structure such that models are organized in a logical

manner.
Close: Closes the current model.
Save: Saves the current model to the <model_name>.SVM file. It should be noted that in

previous versions models were continually saved in the database format. The current
design works similar to Microsoft Word in that any changes made to a model which are
not specifically saved will be lost. It is recommended that the save command be initiated
every 15 to 30 minutes during model creation.

Save As: Allows the user to save the current model under a new name. Once a model is saved under
a new name, the software: i) creates a new folder on the same level as the current folder,
and ii) saves the current newly named model to the created folder.
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9.1.2 Exporting

It is important that the graphics in the modeling software be exported in a professional quality format. The
export menu options provide a high quality format to the user.

Export Geometry: This function provides a method for exporting current model geometry to a text file.
Only the geometry is exported. Flux sections, artwork, boundary conditions, soil
properties and other non-geometry objects are not exported. The purpose of this function
is to allow the export of the geometry for import into a different numerical model for
comparison purposes. The following should also be noted with this feature:

o Circle objects are not exported.

e Comma-separated formatting is used which can easily be imported into Excel.

e Column titles in the export file are: Region, Shape, x- and y-coordinates (a closing point should be
written out for each region: the starting and ending points are the same)

o File is always written out to the current model folder.

o 3D: Surface files are written out to a separate file within the same folder. The title of this file is
<Selectedname_Surface>.txt". Format of the file is: Surface, X, y, z.

Export As: Exporting of the current model in the form it is displayed in the CAD window can be
accomplished with the Export As function. Supported raster formats are .BMP, .EMF,.
GIF, JPG, .PNG, .TIF. High quality vector output is available by performing the export
function using the EPS format.

9.1.3 Printing

Functions associated with printing the model design are as follows:
Page Setup: Standard Windows printer setup dialog.

Print: Opens the Windows standard print dialog so that the image in the CAD window can be
sent to the currently selected printer. The image will automatically be scaled to fit on the
current page.

Print Preview: Opens the standard Windows print preview dialog.

9.1.4 Send Email

This option allows the user to quickly email the model that is currently opened to another person. This option
is particularly useful if the file is being sent to SoilVision Systems Ltd. in order to receive technical support on
a particular issue. A duplicate of the sent email is always emailed to the sender. It should also be noted that the
return email will be set to "soilvisionsystems@gmail.com™. The user should not reply to this email as it is
never checked by the staff at SoilVision Systems Ltd.

If the model being attached requires any .TRI or .TBI files as input, these files will also be attached to the
email provided they are present in the local directory.

9.1.5 Check USB Security Key

Use this option to quickly check the status of your USB Security Key. The security routine will be executed
and any errors in accessing the security key or authorizing the current software will be provided.

This option is useful if you unplug your security key often or are accessing a network security key where
multiple licenses may be in use.
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9.2 Model Menu

The modeling menu contains the primary commands for the creation of a numerical model. The user should
progress through the menu in a top-to-bottom fashion in order to successfully create a numerical model.

9.2.1 Model Properties

The model properties dialog contains general information related to the current model. The project under
which the current model is organized as well as the System and the Type of the current model are recorded.
None of the parameters in this dialog can be edited. The proper procedure for changing any of the model
properties is to save a copy of the current model under a new folder / model name.

9.2.2 Model Settings

The following sections describe the model settings, finite-element options, and their related dialogs.

This dialog is used to set the units and transient settings for a model. As well, the solver finite element options
and solution files path are accessed from here. Global options for the model are located on the Settings dialog.

9.2.2.1 General Tab

e System
The system chosen for the model is displayed here (2D or 3D). The system is also displayed on the
workspace at the top for easy reference.

e Units
The model units are set to the units of the SVFLUX model that the geometry was imported from.
Modeling may be performed in either metric or imperial units of measurement.

e Processes
CHEMFLUX incorporates the use of the following contaminant transport processes: Dispersion,
Advection, Adsorption, Decay, and Density-Dependant Flow. The option to exclude a process is useful to
compare different scenarios for the same model. To include a process, check the box beside the process
name.

For a more detailed description of each contaminant transport process refer to the
CHEMFLUX Theory Manual.
Tip!

9.2.2.2 Time Tab

The Time section requires input of the total time the model will run for and the desired time increment.

e Model Duration
The model duration is controlled by the Start and End times. Set these values to the desired interval over
which the model is to run. Specific time periods can be examined by adjusting the Start and End times.
For example, the model may be defined over an entire year, but setting the Start = 0 and the End = 1 will
allow examination of only the first day.

e Initial Increment
The initial increment will be the initial time step estimate for the model. If the solver cannot meet the
desired accuracy this time step will be refined until the required accuracy is met. The automatic
time-stepping algorithm is free to select an optimal time-step which is higher or lower than the
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user-selected initial time-step guess.

Maximum Increment

If the solver's automatic time-step algorithm chooses a time increment that is greater than the increment of
certain input data the solver may "miss" input data entries. For example, if daily flux values are provided
and the solver determines it only needs a 5 day increment due to the lack of complexity in the model the
solver will reference the flux data only every 5 days. This means that flux values in between this interval
will not be captured.

The Maximum Increment will force the solver to report values at the specified increment and therefore
capture any input data points specified at intervals greater than it. If a Plot or Output file created using the
Plot Manager has a time increment that is lower than the Maximum Increment, the plot or output file
increment will be considered as the maximum by the solver.

9.2.2.3 Advection Tab

Advection Control

The Advection Control setting specifies how groundwater gradients are provided to the CHEMFLUX
model. The first option, Import from SVFLUX, requires a transfer (TRN) file created by SVFLUX. The
second option requires constant or functions for groundwater gradients in the X and Y directions for a 2D
model and in the X, Y, and Z directions for a 3D model also specified on the Advection tab.

Gradient File Path

If the Advection Control is set to Import from SVFLUX, use the Browse button to provide the location of
the .TRN file created by SVFLUX. If the volumetric water content (vwc) data is present in the selected
file it will be indicated by a checkmark. VVolumetric water content is necessary to use Diffusion curve data
in the soil properties.

Use the Re-link button to re-link the specified gradient file to the current directory structure.

Gradient Definition

If the Advection Control is set to Defined constants or functions are used to describe the ground water
gradients. Provide a value or function for each coordinate direction. Functions must be in terms of X,Y,Z,
or t (time). They may include other mathematical symbols acceptable to the CHEMFLUX solver.

Advanced Advection Dialog
Press the Advanced button on the Settings dialog to open the Advanced Advection dialog.

When advection is the only process selected model solution may encounter numerical dispersion and
numerical oscillations. CHEMFLUX minimizes the effects of numerical dispersion by incorporating
automatic mesh refinement. Automatic mesh refinement allows the solver to refine the mesh at the start of
the chemical front and relax the mesh as the front passes and the concentration becomes constant. The
settings in the Advanced Advection dialog are included to assist in minimizing the effects of numerical
oscillations.

When gradients in a certain direction are set to zero it becomes necessary to supply a small diffusion term
in that direction to overcome numerical oscillations. The diffusion coefficient must be a number that is
less than 1.

If Vx was set to zero and Vy was set to allow flow in the vertical direction a small
diffusion term for the x direction would be needed instead of the y direction.

Tip!

A short example has been included in the Verification Manual to illustrate the use of advanced advection.
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9.2.2.4 Adsorption Tab

Four adsorption isotherms are available in CHEMFLUX. They include the Linear, Langmuir, Freundlich, and
User Defined. The User Defined setting requires the user to input a curve describing the mass of solute
adsorbed versus concentration for each soil. The other three isotherms require the input of the appropriate
constants depending on the isotherm chosen. This data is entered in the Soils dialog.

The Linear method is the most stable adsorption isotherm. For more information on
adsorption isotherms refer to the CHEMFLUX Theory Manual.
Tip!

9.2.2.5 Density Tab

The Density tab provides the parameters for density-dependant flow. The Density checkbox on the Model
Settings - General Tab must be checked to enable this tab.

Enter the Density, Maximum Density, and Maximum Concentration.
9.2.2.6 Front Tab

The FRONT section is used to define additional criteria for use by the adaptive regridder. In the normal case,
FlexPDE repeatedly refines the computational mesh until the estimated error in the approximation of the
PDE's is less than the declared or default value of ERRLIM. In some cases, where meaningful activity is
confined to some kind of a propagating front, it may be desirable to enforce greater refinement near the front.
In the FRONT section, the user may declare the parameters of such a refinement.

The FRONT section has the form:
FRONT (<criterion>,<delta>)

The stated <criterion> will be evaluated at each node of the mesh. Cells will be split if the values at the nodes
span a range greater than (-<delta>/2,<delta>/2) around zero. That is, the grid will be forced to resolve the
<criterion> to within <delta> as it passes through zero. (FlexPDE User’s Manual)

The criterion may be and equation involving any of the variables in the model or any reserved functions. The
primary variable, concentration, c is often used.

9.2.3 FEM Options Dialog
To open the Finite Element Method (FEM) Options dialog, select Model > FEM Options from the menu.

The following descriptions relate to switches used to allow refined control over the FlexPDE solver.
Description of these switches has been taken from the user’s manual of FlexPDE version 5.0. Please see the
documentation distributed with FlexPDE for further explanation regarding the use of these parameters.

When the dialog is opened the fields contain the defaults that are used in the CHEMFLUX solver. If at any
time you wish to return to these default values after making changes click the Reset button. The defaults used
initially correspond to FlexPDE version 5. If you wish to use FlexPDE version 4, select the Solver Version at
the bottom of the dialog. Note that there are different defaults depending on the version chosen.

Primary Controls
FlexPDE allows a significant number of options related to general model solution. The following FEM
Option settings are of primary importance for solving contaminant transport models.

ERRLIM default: 0.001
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It is suggested for most models that this value not be greater than 0.001 or numerical errors may be
introduced.

STAGES default: 1
The STAGES setting is primarily used in one of the following two ways:

1) For unsaturated soil models the STAGES are set to two. The first stage solves the model for saturated
conditions and the second stage solves for unsaturated conditions. This method improves the ability
of the solver to handle the non-linearity associated with unsaturated soil models.

2) Models involving stochastic analysis will run the number of iterations controlled by the STAGES
parameter. For example, for a Monte Carlo analysis it may be typical to set STAGES to 200. 200 runs
of the model will then be performed while varying a soil property with Monte Carlo generated data.

MESH SPACING
Used to control mesh density. This is a global settings, any mesh spacing provided at the region level will
override this global parameter.

ALLIGN MESH

This setting takes the 2D mesh of surface 1 and projects it through the rest of the surfaces. It is intended
for cases where the layers are too thin to allow the mesh generator any latitude in joining irregular
surfaces.

If higher surfaces have different boundary features than surface 1, the mesh will not match the domain
requirements. You can't align meshes if the boundaries don't align.

The following points should be noted:

1) Each surface is gridded independently as a 2d triangular mesh.

2) Layers are then filled by generating tetrahedra off the triangles of the bounding surface meshes.

3) If the surfaces are irregular, then two adjacent surface grids may not have the same layout of nodes.
4) If the layer is very thin, the 3D mesh generator may not be able to find tetrahedra that fully link the
disparate surfaces.

5) ALIGN_MESH was created as a patch to cover this case by forcing the surface meshes to have their
nodes in alignment, so that building linking tetrahedra is easy. It does this by copying the lower surface
mesh (surface 1 in the global SELECT ALIGN_MESH case) to the upper surface or surfaces.

Since it is a kludge to get around a difficult case when very thin layers have irregular surfaces, it should be
used only when that condition is
present.

GRIDLIMIT
Maximum number of REGRIDS before a warning is issued. Batch runs stop at this limit. (FlexPDE Users
Manual) Default - 8.

REGRID
By default, the solver implements adaptive mesh refinement. This selector can be used to turn it off and
proceed with a fixed mesh. (FlexPDE User’s Manual) Default — Yes.

SMOOTHINIT
Implements a mild initial-value smoothing for time dependent models, to help ameliorate discontinuous
initial conditions. (FlexPDE Users Manual.) Default = No.

NODELIMIT
Specifies the maximum node count. If mesh refinement tries to create more nodes than the limit, the



SOILVISION SYSTEMS, LTD. Menu System 30 of 108

cell-merge limit will be raised to try to balance errors across a mesh of the specified size. (FlexPDE Users
Manual) Default — 1000000 (Full), 800 (Student)

NGRID
Specifies the number of mesh rows in each dimension. (FlexPDE User’s Manual) Default — 15 (2D Full),
10 (3D Full), 10 (2D Student), 5 (3D Student).

In all cases, the mesh generator evaluates the several mesh size controls and takes the MINIMUM value
for the imposed cell size. There is also an influence function, so that a control in one region is felt in its
adjacent regions with an influence that dies with distance. Therefore, if other mesh controls are specified,
such as NGRID, the minimum will be used.

STEEPNESS
This selector allows the control of base mesh density in 3D models with curved or irregular surfaces.
STEEPNESS specifies the maximum midpoint deviation of a cell face from a flat surface, as a fraction of

the base cell size. Smaller STEEPNESS values create smaller base mesh cells. (FlexPDE Users Manual)
Default - 0.5

Alphabetical Listing of FEM Options Fields
The following finite element options are listed in alphabetical order and are taken from the FlexPDE
user’s manual version 4.0. The defaults listed are applicable for version 4.0 of FlexPDE.

CHANGELIM default: 0.5(steady state)

default: 2.0(time dependent)
Specifies the maximum change in any nodal variable allowed on any Newton iteration step (measured
relative to the variable norm). In severly nonlinear models, it may be necessary to force a slow progress
toward the solution in order to avoid pathological behavior of the nonlinear functions.

CuBIC default: Off
Use cubic Finite Element basis (same as ORDER=3). The default is quadratic (ORDER=2). Cubic basis
creates a larger number of nodes, and sometimes makes the system more ill-conditioned.

ERRLIM default: 0.001

This is the primary accuracy control. Both the spatial error control XERRLIM the temporal error control
TERRLIM are set to this value unless over-ridden by explicit declaration.

[Note: ERRLIM is an estimate of the relative error in the dependent variables. The solution is not
guaranteed to lie within this error. It may be necessary to adjust ERRLIM or manually force greater mesh
density to achieve the desired solution accuracy.]

EXIT DONE default: Off

This is a command line switch that will cause the solver to close once the analysis is complete. This
feature is useful when using the software with a network dongle. Once the analysis is complete the solver
license can be freed for other users.

FIRSTPARTS default: Off

By default, FlexPDE integrates all second-order terms by parts, creating the surface terms represented by
the Natural boundary condition. This selector causes first-order terms to be integrated by parts as well. Use
of this option may require adding terms to Natural boundary condition statements.

FIXDT default: Off
Disables the automatic timestep control. The timestep is fixed at the value given in the TIME section.

HALT default: 1E-18
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This statement will cause the computation to halt if the automatically controlled timestep drops below
minimum. This facility is useful when inconsistencies in data or discontinuities in parameters cause the
timestep controller to become confused.

Halt At Equilibrium: If you plot a HISTORY of some meaningful diagnostic value, like temperature at a
point, or GLOBALMAX(temperature), you can determine by observation what amount of time is
necessary to reach equilibrium. In most cases, your diagnostic value will approach equilibrium
asymptotically, so you have to decide what deviation from the ultimate value is sufficiently close to be
called "equilibrium". You can state a HALT condition in your script. When the value of the condition
becomes true, the computation will halt.

HYSTERESIS default: 0.5

Introduces a hysteresis in the decay of spatial error estimates in time-dependent models. The effective
error estimate includes this fraction of the previous effective estimate added into the current instantaneous
estimate. This effect produces more stable regridding in most cases.

ICCG default: On
Use Incomplete Choleski Conjugate-Gradient in symmetric models. This method usually converges much
more quickly. If ICCG=0FF or the factorization fails, then the Orthomin method will be used.

ITERATE default: 1000 (steady-state)

default: 500(time-dependent)
Primary conjugate gradient iteration limit. This is the count at which convergence-coercion techniques
begin to be applied. The actual hard maximum iteration count is 4*ITERATE.

LINUPDATE default: 5
In linear steady-state models, FlexPDE repeats the linear system solution until the computed residuals are
below tolerance, up to a maximum of LINUPDATE passes.

MERGDIST default: 0
In the initial domain layout, points closer than MERGEDIST will be coalesced into a single point. This
helps overcome the effects of roundoff and input number precision in generation of domains..

MODES default: 0
Selects the Eigenvalue solver and specifies the desired number of modes. The default is not to run an
Eigenvalue model.

NBCMEASURE
Improves water balance calculations in 3D models. Default — Yes.

NEWTON default: (2/changelim)+20
Overrides the default maximum Newton iteration limit.

NONLINEAR default: Automatic
Selects the nonlinear (Newton-Raphson) solver, even if the automatic detection process does not want
it.

NONSYSMMETRIC default: Automatic
Selects the nonsymmetric Lanczos conjugate gradient solver, even if the automatic detection process does
not want it.

NOTIFY_DONE default: Off
Requests that FlexPDE emit a beep and a "DONE" message at completion of the run.
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NRMATRIX  default: 5

Sets the maximum number of Newton-Raphson iterations before recomputing the coupling matrix in
steady-state solutions. The matrix is recomputed whenever the solution changes appreciably, or when the
residual is large.

NRMINSTEP default: 0.09

Sets the minimum fraction of the computed stepsize which will be applied during Newton-Raphson
backtracking. This number only comes into play in difficult nonlinear systems. Usually the computed step
is unmodified.

NRSLOPE default: 0.0001
Sets the minimum acceptable residual improvement in Newton-Raphson backtracking of steady-state
solutions.

NRUPDATE  default: 1

Sets the maximum number of Newton-Raphson steps in each timestep in nonlinear time dependent
models. The default (1) seems to give the best balance between cost and accuracy. Strongly nonlinear
models may require 2 or 3. (See PREFER_SPEED and PREFER_STABILITY. Both PREFER_SPEED
and PREFER_STABILITY must be unchecked to change NRUPDATE.).

NRUPFIT default: Off

"ON" requests that FITs and SAVEs be recalculated at each Newton Iteration of nonlinear time-dependent
models. Prior to version 2.20e, these items were computed once in each timestep. The default condition
uses only one Newton step per timestep, so this selector is useful only if NRUPDATE is also set.

ORDER default: 2

Selects the order of finite element interpolation (1, 2 or 3). The selectors QUADRATIC and CUBIC are
equivalent to ORDER=2 and ORDER=3, respectively. Setting the Order = 1 implies a linear interpolation
function.

OVERSHOOT default: 0.001
Sub-iteration convergence control. Conjugate-Gradient solutions will iterate to a tolerance of
OVERSHOOT*ERRLIM. (Some solution methods may apply additional multipliers.)

PRECONDITION default: On
Use matrix preconditioning in conjugate-gradient solutions. The default preconditioner is the
block-diagonal inverse matrix.

PREFER_SPEED default: On

Sets control parameters for time dependent models to the best balance for speedy completion of most
models. Use PREFER_STABILITY for difficult nonlinear models. PREFER_SPEED is equivalent to
NRUPDATE=1, TNORM=2. NRUPDATE and TNORM will be set automatically in the dialog when
PREFER_SPEED or PREFER_STABILITY is selected.

PREFER_STABILITY default: Off

Sets control parameters for time dependent models to a slower but more stable configuration for difficult
nonlinear models. PREFER_STABILITY is equivalent to NRUPDATE=3, TNORM=4. NRUPDATE and
TNORM will be set automatically in the dialog when PREFER_SPEED or PREFER_STABILITY is
selected.

QUADRATIC default: On
Selects use of quadratic Finite Element basis. Equivalent to ORDER=2.
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REINITIALIZE default: Off
Causes each Stage of a STAGED model to be reinitialized with the INITIAL VALUES specifications,
instead of preserving the results of the previous stage.

SENSITIVITY default: 1.0
Controls the balance between space and time errors. Increase sensitivity to create denser spatial grids.
(Obsolete. Replaced by XERRLIM).

STAGES default: 1
Parameter-studies may be run automatically by selecting a number of Stages. Unless the geometric domain
parameters change with stage, the mesh and solution of one stage are used as a starting point for the next.

SUBSPACE default: MIN(2*modes,modes+8)
If MODES has been set to select an eigenvalue model, this selector sets the dimension of the subspace
used to calculate eigenvalues.

TERRLIM default: 0.001

This is the primary temporal accuracy control. In time dependent models, the timestep will be cut if the
estimated relative error in time integration exceeds this value. The timestep will be increased if the
estimated temporal error is smaller than this value. TERRLIM may also be set by use of ERRLIM.

[Note: TERRLIM is an estimate of the relative error in the dependent variables. The solution is not
guaranteed to lie within this error. It may be necessary to adjust TERRLIM to achieve the desired solution
accuracy.]

TNORM default: 2

Error averaging method for time-dependent models. Timestep control is based on summed (2*"TNORM)
power of nodal errors. Allowable values are 1-4. Use larger TNORM in models with localized activity in
large mesh.

TORDER default: 2

Selects the order of the Backward Difference Formula for time integration. TORDER=1 is the classical
backward Euler method. TORDER=2 uses a quadriatic fit over two timesteps. TORDER > 3 is not
supported. The multi-step Backward Difference Formula method (Gear's method) used in FlexPDE is fully
implicit, and is specifically designed to handle stiff systems. Strictly speaking, it is not a finite-difference
method, as it uses an interpolation function and differentiates the interpolator to determine the time
derivative at the end of the multi-step interval. In this sense, it is similar in spirit to the finite element
method, and makes a smooth match with finite elements in space.

UPFACTOR default: 1
Multiplier on upwind diffusion terms. Larger values can sometimes stabilize a marginal hyperbolic
system.

UPWIND default: On
"Upwind" convection terms in the primary equation variable. In the presence of convection terms, this
adds a diffusion term along the flow direction to stabilize the computation.

VANDENBERG default: Off

Use Vandenberg Conjugate-Gradient iteration (useful if hyperbolic systems fail to converge). This method
essentially solves (AtA)x = (At)b instead of Ax=b. This squares the condition number and slows
convergence, but it makes all the eigenvalues positive when the standard CG methods fail.

XERRLIM default: 0.001
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This is the primary spatial accuracy control. Any cell in which the estimated relative spatial error in the
dependent variables exceeds this value will be split (unless NODELIMIT is exceeded). XERRLIM may
also be set by use of ERRLIM.

[Note: XERRLIM is an estimate of the relative error in the dependent variables. The solution is not
guaranteed to lie within this error. It may be necessary to adjust XERRLIM or manually force greater
mesh density to achieve the desired solution accuracy.]

Variables Tab

THRESHOLD (Version 4.x of FlexPDE)
The THRESHOLD command replaces the RANGE command available in earlier versions of FlexPDE.

An optional THRESHOLD clause may be associated with a variable name. In most cases, the use of
THRESHOLD is meaningful only in time-dependent models with uniform initial values.

The THRESHOLD value determines the minimum value of the variable for which FlexPDE must try to
maintain the requested ERRLIM accuracy. In other words, THRESHOLD defines the level at which the
user begins to lose interest in the details of the solution.

Error estimates are scaled to the greater of the THRESHOLD value or the observed range of the variable,
so the THRESHOLD value becomes meaningless once the observed variation of a variable in the model
domain exceeds the stated THRESHOLD.

RESOLVE

The RESOLVE section is used to define additional criteria for use by the adaptive regridder. In the normal
case, FlexPDE repeatedly refines the computational mesh until the estimated error in the approximation of
the PDE's is less than the declared or default value of ERRLIM. In some cases, this can be achieved with a
much less dense mesh than is necessary to make pleasing graphical presentation of derived quantities, such
as derivatives of the system variables, which are much less smooth than the variables themselves. The user
may declare one additional variable whose detailed resolution is important. (FlexPDE User’s Manual)

By default the partial differential equations are solved in terms of concentration. Selecting a variable in the
RESOLVE box will refine the solution based on this variable as well as concentration.

9.2.3.1 Custom Definitions

The Custom Definitions dialog allows the user to enter their own finite element switches into the current
analysis. This is primarily to accommodate newer switches which may be implemented in FlexPDE which
have not yet been implemented in the front end software modules.

9.2.4 Geometry

CHEMFLUX provides many features for describing your model. The model geometry can be entered quickly
by a number of different methods. For CHEMFLUX models, geometry can be drawn manually, copied from
another CHEMFLUX model, or imported from a .DXF file. Instructions on how to perform these operations
are provided below. The following sections describe all the operations available to increase the ease and speed
at which models can be defined.

9.2.4.1 Regions

A region in CHEMFLUX is the basic building block for a model. A region represents both a physical portion
of soil being modeled and a visualization area in the CHEMFLUX CAD workspace. A region will have a set
of geometric shapes that define its soil boundaries. Also, other modeling objects including features, flux
sections, text, and line art are defined on any given region.
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A region in CHEMFLUX is similar to a layer in AutoCAD® on which one or multiple shapes may be drawn.
A region will have a set of one or more geometric shapes that define its soil boundaries. Other geometry
objects associated with a region include features which may be drawn internal to any particular region.

Regions can be imagined as a stack of transparent papers on which to draw. The sheets can be re-ordered,

deleted, or sheets can be added to the stack. In this organizational structure modeling objects are drawn on the
current region.

The following points are important to note when working with regions in the software.

e Each region may be assigned only one soil property. The soil property assigned to a region then applies
to all shapes on that region.

e Boundary conditions may be applied to any shape within a region.

o Features must be drawn as to be internal to the currently selected region. A node point of a feature
polyline may not fall outside of the shapes on the currently selected region.

Consider the following diagrams. In the first diagram region 1 is visible and 2 region shapes have been drawn
on it in red. Line art has also been drawn on region 1 and the textbox “Region 1" has been added. Diagram 2
shows region 2 visible with one rectangular region shape in green, a feature, and the textbox “Region 2”.
Region 3 has the blue region shape, a flux section, and the textbox “Region 3” as shown in diagram 3. The
final diagram is the combination of all 3 regions visible in the workspace.

Diagram 1 Diagram 2
Region1 %
[@2]
i

Diagram 3 Diagram 4
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Region 2
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T Region3

Region Hierarchy
The region hierarchy determines which regions soil properties will prevail if region overlap. In the above
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diagrams the region order is Region 1, Region 2, then Region 3. Since Region 3 overlaps both Region 1
and Region 2 its soil properties will take precedence in the overlapped area.

9.2.4.1.1 Regions Dialog

Regions, geometry, and boundary conditions are created in the same way for 2D, Plan, and Axisymmetric
analysis. The difference is only the coordinate variables used and the governing partial differential equations.

e Adding Regions
To add a region click on the New button and a region will be added to the end of the list. If you are
unsure how many regions to include in your model, a good rule of thumb is to have at least one region for
every soil type you have defined. After that, the number of regions it takes to solve a model is dependant
on by the complexity of the geometry.

o Deleting Regions
Regions may be deleted by selecting a region in the list box and pressing the delete key. It should be noted
that all shapes on that region will be deleted. The existing plots and monitors will also be evaluated and
relevant plots may be deleted. For example, if a contour plot of volumetric water content has been
requested in the dam "core" and the "core" region is deleted, the contour plot will also be deleted.

e Ordering/Overlapping Regions
Ordering of regions should be completed in CHEMFLUX prior to any modeling. It is important to realize
that the order regions appear in the list will affect the solution of the model. If two regions overlap in the
drawing space, the properties of the region that is lower in the list will override the properties of the region
that is higher in the list. For example, in the below case it is desired that the properties of the core
override the properties of the dam. Therefore the Core should be placed below the Dam in the list of
regions.

Core be bw Dam Coreabove Dam

Use the Move Up and Move Down buttons to arrange the regions in an appropriate order. Each click will
move the region up or down once in the stack.

e Naming Regions
When a region is added, it is given a name that is equal to its number in the list. To change this name to
something more descriptive, highlight the name and type in a new one. CHEMFLUX does not allow
duplicate region names within a model.

K It is highly recommended that unique region names be provided that are different than the
defaults. If you are moving regions up and down in the stack the default names will not change
Tip! accordingly. For Example if Region 3 is added and subsequently moved up 2 positions to

position 1, its name will remain Region 3.

e Turning Regions On and Off
A region may be turned on or off by clicking on the region check box. A region that is turned off will not
appear in the drawing space, but will still be included in the model solution.
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K If you are having trouble selecting a region from the drawing space because of an overlapping
region, open the regions dialog and turn the overlapping region off.
Tip!

e Locking Regions
To lock a region click on the Lock checkbox, the symbol should now appear to be locked indicating that
the region has in fact been disabled. When a region is locked it means that you will not be able to select
any objects on it with the mouse or add any objects to it. Therefore any action that requires you to first
select a region cannot be carried out for the locked region. Locking is strictly for the purpose of model
visualization and will not affect the way the model is sent to the solver.

e Specify a Soil
To define a soil for a region choose one from the list of available soils. If there are no soils available, you
must add a soil to the model from the Soils Manager dialog.

e Shapes
Displays the number of shapes drawn on a region. 2D regions may be defined using multiple shapes.

9.2.4.1.2 3D Regions Dialog

3D regions operate in the same way as 2D regions except that they are defined in Plan view. Each region acts
as a “cookie-cutter” through the layers of a model. Also, a 3D region can have a separate soil defined for it on
each layer that it cuts through. As well, separate boundary conditions can be defined for a region on each
layer.

The 3D Regions dialog is very similar to the 2D Regions dialog with the following omissions:

1. Soils are defined in the Region Soils dialog.
2. Only one shape is permitted per region.
3. Boundary condition graphics can be set by surface from the Surfaces dialog.

See the previous 2D Regions dialog section for the functionality of the features on the 3D Regions dialog
section.

9.2.4.1.3 Region Properties Dialog

The Region Properties dialog is very similar for the 2D, Plan, and Axisymmetric systems and provides a
summary of the region properties and allows setting of the dominant shape, the insertion and deletion of
points, selection of a soil, and setting of display properties. In 3D the dialog is the same with the following
exceptions: there is not a selected Soil Name, dominant shape index or select shape combo-box, and there is
only one shape per region.

To open the Region Properties dialog a region shape must first be selected from the drawing space. When a
region shape has been selected, click the Properties button, to view the Region Properties dialog.
Double-clicking any region shape in the drawing space will also open the dialog.

Region Assigned Soil: To define a soil for the region, choose one from the list of
Settings: available soils. If there are no soils available, you must add a soil to the model
from the Soils Manager dialog. (Not present in 3D dialog)

Dominant Shape: In the upper right the number of shapes drawn for the current
region is displayed. The Dominant Shape for the region can be chosen from the
drop-down box by selecting its Shape Index. See the 2D Model section of this
manual for more details. (Not present in 3D dialog)
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Mesh Spacing:

The Mesh Spacing can be controlled for individual regions by providing a
constant or an equation in terms of X,Y,or Z (R,Z for Axisymmetric). The
region mesh spacing provided will override the global setting.

Mesh spacing is set in this dialog at the region level. With this setting the
maximum distance between any two adjacent nodes within the region may be
set. For example, a setting of 0.2m will enforce that the maximum distance
between any two node points in a region will not exceed 0.2m. It is possible for
the spacing between nodes to be less than this value. This is especially true if
mesh refinement is enabled.

9.2.4.1.3.1 Shapes

Regions may contain one or an unlimited number of shapes. A shape may be defined as a closed polyline or a
circle. In the region properties dialog each shape is given its own designated tab. The user may select a shape
to edit by clicking on the appropriate tab. Shape data can be edited directly in the list box or it can be cut and
pasted in from other Windows software.

The functions listed below allow the user flexibility and operating on the shape data presented in the selected

tab.

Shape Tab:

Insert:

Shapes within a current region are listed on one or more tabs on the Region Properties
dialog. The list control lists all the points that make up the current geometric shape.
CHEMFLUX allows you to edit the coordinate for any point directly in this table. Any
changes to the coordinates will be seen when the OK button is clicked.

When a circle shape is selected the Shapes portion of the dialog will display the fields
for the circle center coordinates and the radius. Note that points cannot be inserted or
deleted from a circle shape nor can a fillet be applied.

Fillet Radius: Applying a fillet to a point can improve mesh generation and
solver convergence by rounding shape corners. Enter a radius value
for the fillet.

Mesh Spacing: Use the mesh spacing option to force the solver to create
nodes along the shape segment at the given spacing. If mesh
refinement is turned on the solver has the liberty of placing more
nodes on the specified boundary but not less. Mesh spacing should
therefore be considered an upper limit.

To insert a point into a region shape select the point to insert the new point before and
click Insert. A duplicate of the selected point will be created. The user must then
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supply coordinates for the new point.

Paste: To paste in geometry data in the 2D or 3D Region Properties dialogs click the Paste...
button on a shape tab to open the paste dialog.

In the application you are pasting from ensure the column heading exactly match those
in CHEMFLUX (X, Y). For Axisymmetric coordinates also use (X, Y) for pasting.
Select the data including the column headings. Use Ctrl + C on the keyboard to add
the data from the other application to the clipboard. Select the first record in the list by
highlighting the arrow as shown above and press Ctrl + V on the keyboard.

If the data being pasted does not have a last point that is the same as the first point
select the Generate Closing Point option. Polygon region shapes must be closed.

K If pasting a circle shape be sure that the Generate Closing Point
option is unchecked.
Tip!

Divide Segment: Click this button to open the Divide Region Segment dialog. This feature
includes the ability to divide a region segment into a given number of smaller
segments or into segments of a given length.

9.2.4.1.3.2 Display Properties

Style, color and weight of the border line comprising a region may be changed. The interior color of each
region is defined by the material which is selected for that region. The following settings may be adjusted in
the Region Settings group box on the Region Properties dialog.

It should be noted that if the user displays boundary condition graphics under the View > Options dialog then
the boundary condition line-type (grey) will override any region color settings

Show Region The user may select if they want to display the fill color. The fill color is

Fill: assigned to a particular soil type.

Style: This property is the line type for the region border.

Color: Click the color box to open the Color dialog and change the color of the region
border line.

Weight: Select the pixel weight for the border thickness.

9.2.4.1.3.3 Divide Segment Dialog

The left section of the dialog provides information on the shape segment selected for division. To divide a
segment, provide either the number of smaller segments to divide the segment into or the length that the
divisions will be. The converse option will be calculated automatically. If the division length is set, then the

segment will be divided into equal smaller segments of that length starting at the Start point. The last segment
will be the remainder.

It should be noted that the line segment FOLLOWING the selected node point will be divided.
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9.2.4.1.3.4 Copy From

This dialog allows the user to copy points from another region to the current region. Any region from within
the current model may be copied to the current region.

Select Select a region within the current model.

Region:

Select Select a shape within the region.

Shape:

Offsets: Offsets may be applied in the x or y direction to move the shape during the

copy process. Offsets may be applied in the x or y directions.

9.2.4.1.3.5 Limited Region (3D Only)

Regions may be limited by which layers to which they apply. This feature is controlled by the Limited Regions
dialog. Limited regions only apply when building a 3D numerical model. If the user is creating a 3D model the
Limited Regions button will appear at the bottom of the Region Properties dialog.

By default a region will extrude through all layers encountered in a 3D model. In the Limited Region dialog

the user may specify that the current region only applies to certain layers. Layers are always numbered from

the bottom to the top. For example, Layer 1 is always comprised of Surface 1 on its bottom and Surface 2 on
it's top.

9.24.2 Features

Features are used to define internal boundary conditions and provide control of the finite element mesh.
Features are independent of regions and apply to all surfaces in 3D as well. Nodes and cell sides will be
generated along a feature in the finite element mesh.

A feature in CHEMFLUX is a polyline which is drawn internal to the shapes on any particular region. A
feature may be used for the following purposes:

o A feature will be explicitly represented by nodes and cell sides. As such the user may use a feature to
specify a certain node spacing along a feature line.

o Feature subsections are used when a problem has internal line sources; when it is desirable to calculate
integrals along an irregular path; or when explicit control of the grid is required. Internal boundary
conditions may be associated with a feature.

¢ In 3D models, features should be used to delineate any sharp breaks in the slope of extrusion surfaces.
Unless mesh lines lie along the surface breaks, the surface modeling will be crude.

o A feature is extruded through all surfaces of a 3D model unless limited by the Limited Feature dialog.

e Adding Features
To add a feature using the mouse, follow these steps:

From the region selector, select the region the feature will be added to.

From tools click on the feature button, or select Draw > Feature from the menu.

Using the mouse draw the feature.

Features in CHEMFLUX are polylines so double click on the last point to complete the feature
and add it to the model.

pPLONME
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To add a feature using the command line, use the following steps. When entering coordinates in the
command line, the format is the X coordinate, followed by a comma and the Y coordinate. (R and Z if
Axisymmetric) When on the last point of a feature enter the letter “f” to finish the feature.

From the region selector, select the region the feature will be drawn on.

From tools click on the feature button, or select Draw > Feature from the menu.
Enter the first coordinate point for the feature.

Press the Enter key.

Enter the remaining points in the same manner.

When the desired points have been entered, type “f”

Press the Enter key to complete the feature.

NoohkwhE

e Deleting Features
To remove a feature from the model select in with the mouse and press the Delete button or use Edit >
Delete Selected Object from the menu.

K If many features are to be added, you may wish to create a separate region just for
adding features. This way the features for a model may be turned off so that the
Tip! model does not appear cluttered. You will not need to define a soil for the region as
long as the only shapes on the region are features, line art, or text. Features present
on a region that is turned off are still included in the model solution.

e Feature Considerations
Features should not be added outside the domain of any model. The following will illustrate the best way
to add features to a model.

Optimal Acceptable

Adding a feature to a certain region does not restrict the feature to just that region. For example, in the
above case the feature may have been added to the Dam region. It can be seen from the picture that the
feature extends through the Core region as well. The feature is therefore included in both the Dam and
Core regions. To include the feature on only the Dam region, you would need to draw two features, one
on either side of the Core.

Surfaces in most 3D models tend to be irregular. Features are used to cause the CHEMFLUX solver to
have a greater chance to interpret exactly how you want the surface to appear. The CHEMFLUX solver
makes use of bilinear interpolation to create a finite element surface based on each surface grid specified
in the CHEMFLUX front end. The edges of surfaces may often appear rounded due to this bilinear
interpolation. Adding a feature to a surface will cause a distinct edge or a crease to be created in the finite
element mesh.

As a general rule a feature should be added where there is a major crease in the surface. This is illustrated
by the below figure.
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In this case there are three major creases in the surface. Three features were added to cause the mesh to
regrid at these creases. In 3D models it is not acceptable to have a feature that is drawn outside the
domain of the model. All features must be within the model domain as illustrated above.

9.2.4.2.1 Feature List Dialog

This dialog lists all the features that have been defined for the current model. The region that the feature is
drawn on is displayed. Note that features are independent of regions and apply to all regions they intersect. In
3D, features apply to all surfaces. Nodes and cell sides will be generated along a feature in the finite element
mesh. Select a feature from the list and click the Properties button to open the Feature Properties dialog. To
remove a region from the model, select it and press the Delete button.

K Features may also be deleted using the Delete option in the Toolbar.

Tip!
Select Model > Geometry > Features to open the feature list dialog.
9.2.4.2.2 Feature Properties Dialog
The user may double-click on a feature in the Workspace to open its properties dialog. This dialog is also
accessible by selecting a feature in the Workspace and then by pressing the Properties button or from the
Feature List dialog. Points may be inserted, deleted, or edited for the feature on this dialog. Features are

always drawn as black dashed lines.

The Feature Properties dialog may be accessed through the Model > Geometry > Feature Properties menu
option.

Insert Point: To insert a point into a feature, select the point to insert the new point before and click
Insert Point. A duplicate of the selected point will be created. Supply coordinates for the
new point.

Paste Points: Pressing the Paste Points button will paste any data currently on the clipboard into the
feature points list. The data on the clipboard must be in table format.

Delete: Select the point(s) to be deleted and press the DEL key or the Delete button to remove it
from the feature.

Delete All: In this option all points comprising the current feature are deleted.

Mesh Spacing: Use the mesh spacing option to force the solver to create nodes along the shape
segment at the given spacing.
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K The smaller the node spacing the denser the mesh becomes. You may wish to
increase the density of your mesh around flux sections or where you expect
Tip! themodel to have high gradients. The increased mesh density will aid in
model convergence and accuracy.

Format Tab: The Format tab allows setting of the feature line style, color, and weight.
9.2.4.2.3 Limited Feature (3D Only)

Features may be limited by which layers to which they apply. This feature is controlled by the Limited
Features dialog. Limited features only apply when building a 3D numerical model. If the user is creating a 3D
model the Limited Features button will appear at the bottom of the Feature Properties dialog.

By default a feature will extrude through all layers encountered in a 3D model. In the Limited Feature dialog
the user may specify that the current feature only applies to certain layers. Layers are always numbered from
the bottom to the top. For example, Layer 1 is always comprised of Surface 1 on its bottom and Surface 2 on
it's top.

9.2.4.3 Surfaces Definition

Surfaces are defined as elevations over the extent of the model as described by the region geometries. There
are 3 options for defining each surface.

Elevation The surface is described by an grid of points with an elevation provided at each
Data: X,Y coordinate. The grid may have regular or irregular X and Y gridline
spacing and need not be defined over the entire model geometry.

Expression: The surface can be described as a constant elevation, as an equation, and may
reference other Surface Definitions.

Mixed: The surface is described using a combination of the above 2 methods.

The general steps for defining a surface are thus:

1. Choose a surface definition option as described above.

2. Define the surface using the Surface Definition dialog features.

3. Specify any minimum or maximum elevations for the surface in order to minimize difficult
meshing situations.

9.2.4.3.1 Surfaces Dialog

The Surfaces dialog lists the surfaces that have been created for a model. Surface 1 is the lowest surface in the
model (elevation-wise). Surfaces 2, 3, 4, etc. are all in sequential order above surface 1. The surface name and
definition are displayed along with surface grid and boundary condition display options.

e Insert Surfaces
Follow these steps to insert a surface in the Insert Surfaces dialog:

1. Click the New button on the Surfaces dialog.

2. Input the number of new surfaces to be inserted.

3. Select where the new surfaces should be placed among the other surfaces. The default is at the top
of the stack. To place the new surfaces below a surface select the desired surface from the
drop-down.

4. While inserting surfaces it is possible to copy an already existing surface grid to the new surfaces.
Choose to insert with default grid or to copy the grid from an existing surface.

5. If asurface grid is being copied, select which surface the surface grid is to be copied from.
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6. If asurface grid is being copied, select whether to exclude or include elevations while copying the
surface grid.

7. If asurface grid is being copied and elevations have been selected to be included, the elevations
may be offset by a constant from the original elevation.

K The Offset Elevations option allows the flexibility to provide separation of a
new surface from an existing surface easily. If 5 surfaces are required with an
Tip ! equalspacing of 10m, insert a surface 5 times setting the offset to 10m each
time.

e Deleting Surfaces
To delete a surface from the model select the surface from the list and click Delete. A dialog will ask you
to confirm the action before the surface is deleted from the model. Note that surfaces are always numbered
sequentially with Surface 1 being the lowest surface.

e Properties Button
Click the Properties button to open the Surface Properties dialog for the selected surface.

e Turning Surface Grids On and Off
To turn on a Surface Grid select the checkbox for the appropriate surface. The brown gridlines will appear
in the Workspace. To turn off the surface grid deselect the checkbox. As with region geometry on a
surface that is turned off, surface grids that are turned off will still apply to the model solution. Note that
Surface Grids are independent from regions.

e Turning Boundary Condition Graphics On and Off
To turn on the boundary condition graphics for all the regions for a surface select the BC checkbox for the
appropriate surface. The graphics will appear overtop the region geometry in the Workspace. To turn off
the graphics deselect the BC checkbox. Boundary condition graphics do not affect the model solution. The
graphics may only be on for 1 surface at a time.

e Turning Translucency On and Off
To turn on translucency select the checkbox for the appropriate surface. The graphics will update
automatically. To turn off the translucency deselect the checkbox.

e Translucency Value
This expresses the opacity value for the corresponding surface in a decimal form.

9.2.4.3.2 Surface Properties Dialog

The Surface Properties dialog is used to describe individual surfaces. The generally steps to defining a surface
were described previously and these steps will be described in more detail in the following sections. To open
the Surface Definition dialog, select Model > Geometry > Surface Properties from the menu.

The surface definition as seen by the solver is displayed at the bottom of the Surface Definition dialog if the
Advanced button is used to expand the dialog. This definition will be updated dynamically as changes are
made on the Surface Definition dialog. If the Lock option is checked then the surface definition will be frozen
and will not be affected by any further changes on the dialog. Note that the surface definition is completely
customizable as long as it conforms to the solver syntax. Use the Expression Reference button to access tips
on defining custom surfaces.

Note that a reference of the dialog Surface_1 will reference a given surface expression and that
SurfaceData_1will reference a given surface data set.

The Surface Definition Option on the Definition Tab provides the options for defining each surface:
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Elevation The surface is described by an grid of points with an elevation provided at each

Data: X,Y coordinate. The grid may have regular or irregular X and Y gridline
spacing and need not be defined over the entire model geometry. If this option
is selected then the Elevations, Min/Max, and Format tabs will be available and
the Expression tab will be disabled on the Surface Properties dialog.

Expression: The surface can be described as a constant elevation, as an equation, and may
reference other Surface Definitions. If this option is selected then the
Expression, Min/Max, and Format tabs will be available and the Elevations tab
will be disabled on the Surface Properties dialog.

Mixed: The surface is described using a combination of the above 2 methods. If this
option is selected then all tabs will be present.

9.2.4.3.2.1 Elevations Tab

The Elevations tab will list all the surface grid points for the surface selected. When a (X,Y) point is selected
in the list, the point is highlighted in the drawing space. This allows visualization of the point that the
elevation is being defined for. The minimum and maximum values are listed.

Enter an elevation for each X,Y coordinate.

Surfaces whose elevations are set such that slopes develop that are > 80
degrees may decrease the ability for the solver to converge in these areas. Use
Tip! theView dialog to view each surface and look for problem areas.

Grid Options

o Delete Elevations
By selecting this option all elevation points on the selected surface will be deleted.This option will be
useful to users that wish to remove all current elevations and start fresh.

. Snap Above
The point currently selected will snap to the surface directly above it. If a grid point is not directly above
the current grid point then an interpolated elevation point will be determined using bilinear interpolation

. Snap Below
The point currently selected will snap to the surface directly below it. If a grid point is not directly below
the current grid point then an interpolated elevation point will be determined using bilinear interpolation

. Adjust Surface Overlap
This option allows you to adjust surface elevations for overlapping surface areas. Surfaces can be
compared to one another, and elevations can be adjusted accordingly.

. 3D Plane Interpolation
The software will automatically set the 3D elevation values according to three points. This feature is
useful if the user wants a flat surface at a particular orientation.

o Set Nulls
Null values can be changed to a defined value.

Define Grid

Each surface may be defined as X and Y gridlines. The gridlines may be spaced at regular intervals or at any
variation of irregular spacing. Elevations provided at each intersection point complete the definition of the
surface. When a surface is created in the Insert Surfaces dialog it is given a default surface grid of gridlines at
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X=0,X=10,Y=0,and Y =10.

The surface grid setup is the same for X or Y gridlines using the appropriate tab. The total gridlines for each
dimension will be displayed on each tab and the total grid points for the entire surface are shown at the bottom
of the tab.

e Add Regular
To add surface gridlines provide 3 of the 4 setting fields. The fourth field will be calculated along with the
total number of surface grid points that will be added due to intersections with gridlines in the other
dimension. Use the Add button to add the gridlines at the interval provided. Use the Clear button to blank
all the settings fields to start over.

e Add Irregular
To add surface gridlines at irregular intervals enter the values in the list or paste in external data.

To paste in surface grid data into either of the Add Irregular Gridlines dialogs, in the application you are
pasting from ensure the column heading exactly match those in CHEMFLUX, either X or Y. Select the
data including the column headings. Use Ctrl + C on the keyboard to add the data to the clipboard. Select
the first record in the list in the Add Irregular X Gridlines or Add Irregular Y Gridlines dialog by
highlighting the arrow as shown above. Then press Ctrl + V on the keyboard. Choose whether to apply the
global coordinate offset and click OK to add the gridline data to CHEMFLUX.

e Edit a Gridline
To edit a single gridline value, select it from the list and click Edit. Provide a new value in the prompt
dialog.

e Deleting Gridlines
To delete gridlines select them from the list and click Delete.

The Delete operations may be performed for multiple gridlines at once. Select
the gridlines with the mouse while utilizing the CTRL and SHIFT keys on the
Tip! keyboard. Holding down the CTRL key while selecting will select individual
gridlines. Holding down the SHIFT key while selecting will select all the
gridlines between the selected gridline and the previously selected gridline.

By default a grid with X,Y, (and Z if 3D) gridlines of 0 and 10 is in place. A variable value must be provided
at every X-Y point on every Z gridline. The Paste Grid and Import XY Z Data options are applicable to the
entire 3D grid while the Set Data For Point options apply to a single point and the 3D Plane Interpolation
operation applies only to a single elevation. When the All Z Elevations box is checked the operation indicated
by a checkmark with be applied to the entire 3D grid. Conversely if left un-checked the operation will consider
the elevation in the Z Elevation selector only.

Paste Surface Grid

Surface grids can be copied from one surface to another. Using the Paste Surface Grid function allows a user
to paste the grid points of another surface to the currently selected surface. Elevations can be offset by a
defined interval to further simplify defining the new surface.

Paste Surface Data
Surface data can be pasted from an Excel data file using the Paste Surface Data function. The data points
being pasted to the new surface can be offset on the X or Y axis by a user-defined amount.

Import XYZ Data
X,Y, and Z data points can be pasted to the selected surface by using the Import XYZ Data points function. X
and Y coordinate offsets can also be specified by the user.
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3D Scatter Data
3D scatter data can be added or edited using the 3D Scatter Data Function. Depending on whether a regular or
irregular grid is being defined, the appropriate Grid Type should be selected; regular grid or irregular grid.

e Use Regular Gridlines
By using X and Y gridlines, scatter data points can be defined. Both X and Y gridlines can be defined
using start values, incremental values, number of increments, and end values. The interpolated grid lines
can be viewed by selecting the Interpolated Grid Lines button.

Use the Preview Interpolated Grid Lines button to open a dialog where you can preview the grid lines to
be generated.

e 3D Scatter Data
X, Y, and Z scatter data points can be pasted to the new surface from an excel spreadsheet. Scatter data
points can also be imported from a text file (where each point is seperated by a space) by selecting the
Import from Text File button. Data points can also be entered manually by selecting the Insert Point
button. The data points can be deleted individually by selecting the Delete button or simultaneously by
pressing the Delete All button.

e Interpolation Settings
CHEMFLUX can assign surface data to the selected surface by using interpolation. Select the appropriate
interpolation method and define the interpolation method's settings.

For more information on grids, see the Define Grid dialog.

9.2.4.3.2.2 Expression Tab

The Expression tab is available if the Expression Data or Mixed option is selected for the surface.

e Surface Expression
The Surface Expression field can accept constants, free-form equations, and references to other surfaces.
Note that the surface definition is completely customizable as long as it conforms to the solver syntax. Use
the Expression Reference button to access tips on defining custom surfaces.

Note that a reference of the dialog Surface_1 will reference a given surface expression and that
SurfaceData_1will reference a given surface data set.

e Relative Surface
Select a surface to relate the current surface to. The current surface will be set to the Relative Surface + the
Relative Modifier.

¢ Relative Modifier
Select a surface modifier to adjust the relative surface by. The current surface will be set to the Relative
Surface + the Relative Modifier.

o Update
Use the Update button to update the Surface Expression field.

9.2.4.3.2.3 Min/Max Tab

The situation arises frequently where one surface is required to pinch out into another surface. The Min/Max
tab can be used specify a maximum and/or minimum setting for the current surface. In certain situations it may
be necessary to set a minimum thickness between surface to alleviate solver meshing complexities and speed
up the solution.
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e Set Maximum Elevation
Check this option to apply a maximum elevation to the current surface.

e Maximum Option
There are 3 options for applying the maximum elevation for a surface:

1. Surface Above - The maximum for the current surface will be the surface above.

2. Surface Above Less Separation - The maximum for the current surface will be the elevation(s) of
the surface above minus a user-specified separation.

3. Constant/Expression - A constant, free-form equation, and/or reference to other surfaces can be
used to define the maximum for the current surface.

e Set Minimum Elevation
Check this option to apply a minimum elevation to the current surface.

e Minimum Option
There are 3 options for applying the minimum elevation for a surface:

1. Surface Below - The minimum for the current surface will be the surface below.

2. Surface Below Plus Separation - The minimum for the current surface will be the elevation(s) of
the surface below plus a user-specified separation.

3. Constant/Expression - A constant, free-form equation, and/or reference to other surfaces can be
used to define the minimum for the current surface.

Once a minimum and/or maximum specification has been made it will be displayed with the proper syntax in
the Surface Definition field if it is not locked.

9.2.4.3.2.4 Format Tab

The Format Tab allows users to adjust the grid line color, weight, and style. Surface contour settings can be
changed by pressing the Surface Contour Settings button. Contouring of surfaces is currently only enabled
when the user is using the 2D plan view of a 3D numerical model.

Surface Contour Settings

The Surface Contour Settings dialog allows the user to display color contours of the elevation of a particular
surface. This feature may be useful when trying to draw regions which may relate to the elevations. Surface
contours can currently be viewed when the user is in 2-D plan view mode.

e Surface Tab

The surface tab contains the controls for displaying contours on specific surfaces. The user must first select the
surface to which contouring is to be applied. This is done by selecting the Projection of Surface combo box.
The tab is organized into the following sections.

e Contour Surface
The contour surface can be set with the Projection of Surface combo box. After the variable name is
chosen, the maximum and minimum values of the elevation are shown in the text boxes below the Show
Contour check box.

e Show Contour
The contouring may be turned on or off by selecting or deselecting the Show Contour check box.

e Contour Plot Type
The following four different contour types are currently provided:
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Average Element: Fill each square grid element with corresponding color from the color map according to
the average value of the contour variable of that element.

Flood: Fill the regions between contour lines with corresponding colors from the color map.
Lines: Draw lines of constant value of the specified contour variable.
Lines and Flood (default): Combines the above two options.

To modify the contour type, the user selects the corresponding contour type from the Contour Plot Type
combo box.

e Contour Line Stroke
Formatting contour lines may be performed if the user sets the contour plot type as Lines or Lines and
Flood. These parameters can be set in the Format Contour dialog.

Use Color Map: Selecting this option means that the contour lines will take on the color of the current
zone. This will cause them to be indistinguishable from the contour bands.

Single-color: The contour lines can be colored using a single color, the user can set the color by clicking
the Single Color button.

Style: The user can set the contour line style by clicking the Style combo box.
Weight: The user can set the contour line weight by clicking the Weight combo box.

e Contour Levels Tab

The Contour Levels tab allows the user to set the range and frequency of the contours drawn on the selected
variable. Whether or not labels are drawn which identify the value of each contour may be controlled in this
tab.

The following adjustments may also be made to the contours.

e Show Level Legend
This check box controls whether or not the legend is displayed.

e Setting Contour Levels
The number of contour levels controls the number of distinct contour bands which will be created. The
minimum and maximum of the contoured value may also be controlled. The minimum and maximum
levels are originally defaulted to the actual minimum and maximum variable levels determined when the
user selects the contour variable.

Alternatively the user may select the Delta (change) of the contour intervals. Pressing the Refresh Display
button will apply the latest changes selected.

e Contour Label
The user can display labels next to each contour by selecting this option. Currently the location of each
contour label is automatically selected and cannot be adjusted by the user.

e Color Map Tab
The contour color map is used to specify the colors used to fill the flooded contour plots. The following three
color map types are provided:



SOILVISION SYSTEMS, LTD. Menu System 50 of 108

Auto (Gray): The colors change from white to black.
Auto (RGB): Default color map, the colors change from blue to cyan to green to yellow to red.

Custom: The users set the R, G, B values of the low, intermediate and high level values. All other colors will
be interpreted based on these color values.

The user may also reverse the current color map by clicking Reverse Color Map button. Reversing the color
map is often useful if the user wants to ensure colors are more representative of physical behavior (i.e. blue
zones represent "wet" zones). Pressing the Default button will change all values back to their factory settings.

9.2.4.4 Importing Geometry

Geometry for a CHEMFLUX model can be imported from any other numerical model created with the
SVOffice software. The import includes regions, region shapes, surfaces, surface definitions, world coordinate
system settings, and features. Geometry may be imported using the Model > Import Geometry menu and
follow the instructions in the dialog.

When geometry is imported into a two-dimensional model CHEMFLUX duplicates the regions and the
geometry, including features and format axis settings. CHEMFLUX does not duplicate the soil properties or
boundary conditions for the imported regions.

When geometry is imported into a three-dimensional model CHEMFLUX will duplicate the surfaces, surface
grid and elevations, regions, and geometry, including features and format axis settings. CHEMFLUX will not
duplicate soil or boundary condition information.

9.2.4.4.1 Importing Geometry from .DXF Files

If you have geometry from other applications such as AutoCAD™ in .DXF format it can be imported into
CHEMFLUX by executing the following steps. DXF import is available for all four systems.

Select Model > Import From .dxf... from the menu. The DXF Import dialog will be opened.
Specify the path to the .DXF file and press the Next button.

Select a region or multiple regions from the list.

To preview a region click the View Selection button.

Specify the point order, make the Apply Global Offset choice, and specify the decimal precision.
Press Import to load the selected region into the model.

oaRrwNdE

SVOffice supports DXF files created as AutoCAD 2007 DXF format or earlier. Regions must be polygons or
polylines. Line objects must be converted to polylines before import will be possible. CHEMFLUX will close
region shapes on import where necessary. The user must ensure that the shapes are closed once imported. To
test whether the DXF has shapes that can be imported, open the DXF in a text editor and search for
LWPOLYLINE. If it exists then the shapes tagged as LWPOLY LINE can be imported.

Mesh creation is more efficient if region points are defined in a counter clockwise
fashion. Use ascending and descending to arrange the points on import. Set the
Tip! accuracy of points by specifying decimal places.

9.2.45 Tools

The tools menu provides additional functions which can be used to manipulate the geometry of a model.
Global snapping is useful to ensure that region node points allign between regions. Functions to allow the
cutting of three-dimensional surfaces in order to generate regions are also provided.
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9.2.4.5.1 Snap All

The Snap All function snaps all region points to the nearest grid point. This function is typically used to
ensure that node points on adjacent regions are exactly the same. There can be difficulties created during
mesh generation if adjacent region note points do not touch or slightly overlap. This condition will typically
result in a tangled mesh error. These problems can largely be avoided using the Snap All function.

The following points should be noted with the use of the Snap All function
e Only shapes on regions are snapped. Snapping does not apply to 3-D surface grids.
o All region points are snapped to the nearest grid point according to the current grid settings.

e The Snap All function is global. All shapes on all regions will be affected.
9.2.4.5.2 Cut Surface

The cut surface function allows the user to cut a three-dimensional surface with a plane and generate a region
taste on the resulting intersection points between the plane and the surface.

Cutting Plane Tab:

The cutting plane tab allows the user to select the specifics on how the surface will be cut. Any surface can be
cut with a horizontal or an arbitrary plane. Region points are generated each time the plane surface cuts a grid
line. All generated polylines are closed by the software. The current implementation assumes that only one
polygon will be formed as a result of the cutting operation.

Target Surface: The surface which will be cut by the plane is specified in this combo box. Only existing
surfaces defined by a grid may be used. Surfaces defined by an expression may not be used
in the current algorithm.

Polygonization There are a number of different algorithms for determining the intersection between

Method: two surfaces. Three methods have currently been implemented and are described as
follows. It is up to the user to decide which method best suites the model being
developed. The following descriptions are provided by the McGill University
website.

Regular: This method uses an algorithm developed internally at SoilVision Systems Ltd. in which
node points are joined and it is insured that there are no intersections between lines.

Radar Sweep: The Analogy:
Aboard the USS Batfish SS-310 Submarine the radar scan indicates a multitude of enemy
units scattered in general position. The commander orders that each vessel be attacked in
sequential fashion according to their coordinates starting from West to East. Once the
points are sorted radially from the point where the submarine is located, it will proceed
according to the path connecting every vessel according to the sorted list.

The Algorithm:
The user defines a set of points, P. We then determine the point with the minimum x
coordinate (on the computer screen the origin is located in the top left corner) which we'll
call A. We then sort the remaining points radially with respect to A.
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Finally, we connect A to the first element in the sorted list, and keep doing so until we
reach the last element in the list which we connect to A yielding a simple polygon.

Layers

Surface 2

‘ Surface 1

The Analogy:

In rural Italy, peasants are known to do things in a simplistic fashion, using basic tools and
methodologies. Two such peasants just bought an old farm, which they will use as
headquarters for their dairy products distribution. On this farm they plan on raising cows
in open fields. Upon arriving at the farm the 2 peasants notice that all the fences that used
to surround the pasture have been removed. All that remain are the posts, scattered in
general position. An extra chore the countrymen must do is to build a fence, using all the
posts, to contain the cows within the pasture. Gathering some red rope, one farmer ties a
knot around the closest post from the house (xmin), the other walks away from the house,
pulling the red rope, until he reaches the farthest post (xmax). Now that the posts are
divided into two sets by this red rope, the one closest to the house begins attaching blue
fence from the xmin post to the next closest one in the x-coordinate direction and keeps
doing this from post to post, never crossing the red boundary. The peasant located near the
xmax post does the same thing as his friend, but on the opposite side of the red tape.

The Algorithm:

The user defines a set of points, P. We then scan through the list and find the points with
the smallest and greatest values of x. We store these points as xmin and xmax respectively.
Now, if we can imagine a line connecting the points containing xmin and xmax we see that
the set P is divide.d in two, a lower (P1) and an upper (P2) set.

This imaginary line used to divide the sets was included and is seen in red (the red rope
from the analogy above) as the algorithm is executing.
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Next we sort both sets of points, P1 and P2 according their x-coordinate values. Now the
points are sorted we connect them in succession, forming half sides of the polygon.

° \I\A
Finally we connect the xmin and xmax points to both halves which yields a simple
polygon.

G

Convex Bottom: ~ The Analogy:
The Canadian Military is building a new military vessel. The building crew starts off with
a set of super light weight beams, positioned parallel to the ground. Seen from the would-
be front of the vessel, the beams form a set of points. Next the crew must rivet very
expensive kevlar sheets to the area of the vessel that makes water contact, with this
criterion in mind and the fact that the kevlar sheets are rather costly. the kevlar will be
riveted to the beams closest to the water.

The Algorithm:
We find the two points with the minimum and maximum x-coordinates respectively and
connect them with an imaginary line just like in the 2 Peasant Algorithm.

L]

We compute the convex hull of the lower hemisphere created by this line, and we connect
the points lying on the convex hull.
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The remaining points are then lumped with the ones in the upper hemisphere. We then sort
them according to their x-coordinates and finally connect them. The algorithm used for
finding the lower part of the convex polygon was Graham scan.

Format Tab:

The format tab allows the user to control the exact formatting of the cutting planes and the intersecting line
segment as displayed in the 3-D CAD window.

Show Cutting
Plane:

Format Cutting
Plane:

Show Intersection
Line Segments:

This checkbox allows the display of line segments at the intersection points between
the cutting point in the selected surface. The intersection line segment may be
formatted according to the controls provided which include Style, Color and Weight
as specified in the Intersection Line Segment Stroke group box.

This checkbox allows the display of line segments at the intersection points between
the cutting point in the selected surface. The intersection line segment may be
formatted according to the controls provided which include Style, Color and Weight
as specified in the Intersection Line Segment Stroke group box.

This checkbox allows the display of line segments at the intersection points between
the cutting point in the selected surface. The intersection line segment may be
formatted according to the controls provided which include Style, Color and Weight
as specified in the Intersection Line Segment Stroke group box.

9.2.5 Initial Conditions

This chapter will describe how initial conditions are specified within CHEMFLUX and those dialogs used to
define the initial conditions.

The Initial Conditions dialog allows specification of the initial values of the dominant model variable (in this
case: concentration). Initial conditions may be specified for either steady-state or transient analysis. In
steady-sate analysis the initial conditions only serve as initial guesses for the solver and may increase
likeliness of convergence.
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9.2.5.1 Initial Conditions Option

Initial conditions may be specified in either steady-state or transient models. In steady-state models the initial
conditions form a "first-guess" approximation to the solution and therefore may aid greatly in convergence.

The following options are available for defining the initial concentration conditions:

o Transfer File: Use a transfer file to provide initial concentrations across the entire model at each
node point. Select the transfer file option then specify the path to the desired file using the
Browse... button. A copy of the specified file is saved to the local directory with extension .TRI.

e Table File: Use a table file to provide a regular grid of concentrations across the entire model as
initial conditions. Select the table file option then specify the path to the desired file using the
Browse... button. A copy of the specified file is saved to the local directory with extension .TBI.

e Constant/Expression: A constant concentration can be set throughout the model. Alternatively
an expression may be entered to mathematically describe the initial variable field. Further details
may be found in the Expressions section.

e By Region: This option allows the specification of the initial value of concentration by region.
A list of all current regions will appear in a table format and values may be entered which
correspond to each region.

o Draw Water Table: Select this option to draw a water table in the workspace in 2D or
Axisymmetric models or specify a water table surface in 3D.

e Grid: Provide a grid of concentration values. The grid will be written to a . TBL file that is used
by the solver. See the Initial Conditions Grid form section for instructions on setting up a
concentration grid.

e PWHP Constant / Expression: This option is similar to the Constant/Expression option only
here the initial conditions may be specified in terms of pore-water pressure. It should be noted that
specifying regions as constant pore-water pressures is only recommended for models with small
geometry where the potential hydrostatic pressures are not great.

e PWP By Region: This option is similar to the By Region option only here the initial conditions
may be specified in terms of pore-water pressure. It should be noted that specifying regions as
constant pore-water pressures is only recommended for models with small geometry where the
potential hydrostatic pressures are not great.

Use the Re-link button to re-link the specified transfer or table file to the current directory structure. Whenever
an initial conditions file is specified a copy is made in the local solution files directory. If the specified file is
updated later it will become out of date with the file copied to the local folder. The Re-link button can be used
to refresh the updated file by re-copying it to the local folder.

9.2.5.2 Initial Conditions Grid

The Initial Conditions Grid dialog is used to define an initial conditions grid for the selected variable. A
two-dimensional grid of values can be provided as initial conditions in 2D, Plan, and Axisymmetric models. A
3D grid of values is used in 3D models. See the Define Grid dialog section for information on how to use
these dialogs. By default a grid with X,Y, (and Z if 3D) gridlines of 0 and 10 is in place.

o 3D Dialog Operation
Use the Z Elevation to select the Z gridline to display in the list. A variable value must be provided at
every X-Y point on every Z gridline.
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e 3D Scatter Data
Scatter data can be provided for the initial conditions grid. See the 3D Scatter Data section under
Geometry for more information.

e Import XYZ Data
XYZ data can be provided for the initial conditions grid. See the Import XYZ Data section under
Geometry for more information.

9.2.6 Boundary Conditions

There are a number of different boundary conditions that can be specified in CHEMFLUX including Zero
Flux, Flux Expression, Flux Data, and Concentration Expression.

Boundary conditions are defined at region nodes. The defined boundary condition will then apply to all line
segments following the node until another boundary condition is defined at a following node. Boundary
conditions follow around the nodes of a region in the same order as it was drawn. This approach is different
than that of other software where boundary conditions are applied at specific element nodes. The
CHEMFLUX solver will automatically refine the mesh along any specific boundary line and so there is no
way to determine ahead of time how many nodes will fall on the boundary. Therefore boundary conditions
must be applied to line segments in CHEMFLUX.
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The above region is drawn by entering points A, B, C,... up to point F. A boundary condition specified at
point A will continue to apply to the region around the region boundaries at points B, C, etc. until it is
re-defined at a successive point. If a boundary condition is not specified, the solver will default to a Zero Flux
boundary condition. Reasonable boundary conditions must be defined for each problem to solve correctly.

9.2.6.1 2D Boundary Conditions
Boundary conditions are applied in the same manner for 2D, Plan, and Axisymmetric models.

Boundary conditions must be applied to region points. Once a boundary condition is applied to a boundary
point this defines the starting point for that particular boundary condition. The boundary condition will then
extend over subsequent line segments around the edge of the region in the direction in which the region shape
was originally entered. Boundary conditions remain in effect around a shape until re-defined. The user may
not define two different boundary conditions over the same line segment.

In the above example the points were defined in a counter-clockwise manner. This means that a boundary
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condition specified at the start point is going to extend over the geometry in a counter clockwise direction. It
is not required that you remember the order that points were defined as this will become evident in the
boundary conditions dialog.

9.2.6.1.1 Build Equation Dialog
Click the Build Equation button on any boundary conditions dialog to open the Build Equation dialog.

Specify Starting and Ending values and whether the equation will be in terms of X or Y (Rand Z in
Axisymmetric). Click OK and CHEMFLUX will generate the equation and place in the Expression field on
the Boundary Conditions dialog. Be sure to click OK to save the changes and close the dialog.

9.2.6.2 3D Boundary Conditions

In 3D models boundary conditions are applied to geometry points and extend over line segments in the
direction that the points were originally defined. Line segments in 3D models are extruded between layers in
order to make the walls of the model. The same is true for boundary conditions. A boundary condition that
extends over a line segment is also applied over the wall created when the line segment is extruded between
the layers. Boundary conditions may also be applied to surfaces. This is done in the surface tab on the
boundary condition dialog. Brief examples are included to describe how boundary conditions are applied to
line segments and surfaces.

The upper left portion of the 3D Boundary Conditions dialog displays the region that is current and the
Surface drop-down. Use the Surface drop-down to toggle the dialog between all the surfaces defined for a
model.

e Surface Boundary Conditions
A surface boundary condition does not need to be specified for every surface. None is the default
selection.

1. Select a region from the drawing space.

2. Open the Boundary Conditions dialog by either selecting Model > Boundaries... from the menu or
by clicking the Boundary Conditions button in the tool bar.

3. Select a surface to apply boundary conditions to from the Surface drop-down.

4. Select a boundary condition from the Boundary Condition drop down.

5. If a Flux Expression or Head Expression boundary condition has been selected then fill in the
appropriate field. If a Climate boundary condition is selected then select the name of the data set to
apply to the boundary.

Surface boundary conditions are not automatically applied to above surfaces as
segment boundary conditions are extended around a region. A surface boundary
Tip ! condition selected for Surface 1 will not be extended to Surface 2.
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e Segment Boundary Conditions

Before discussing the boundary conditions the user must know how SVFLUX builds a model. See 3D
Model. SVFLUX builds the model by extruding regions between surfaces and therefore through layers in
a “cookie-cutter” type manner. Extruded line segments become the walls or faces of the model. For
example, in the above model the line segment extending from the point (0,0) to the point (24,0) would be
extruded between the flat bottom surface and the top surface to create the white face shown in the picture.
A boundary condition that is applied to the line segment will also be extruded across the face. Asin 2D,
Plan, or Axisymmetric analysis, if a boundary condition is not specified for a region line segment the
default will be the boundary condition specified for the previous region segment.

The above model consists of only one layer. If the model has more than one layer it may be necessary to
define a boundary condition for a line segment over one layer but not the others. For example, the below
picture illustrates a model with four layers and one region named Region 1.

Layer 4

Layer 3

Layer 2

Layer 1
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It may be necessary to have a X Flux Expression = 0.02 m3/s condition from point A to point B in layer 1
while in layer 3 a Head Expression = 10m boundary condition is required. Below are instructions for
applying the necessary boundary conditions. It should be noted that there are five surfaces in the above
model. Surface 1 is the bottom of Layer 1, Surface 2 is the contact between Layer 1 and Layer2, Surface 3
is the contact between Layer 2 and Layer 3 and so on. Note that in the above diagram layer 2 and layer 4
do not have any boundary conditions applied over the segment AB.

To apply a segment boundary condition, consider the above diagram and follow these steps:

1.

6.

7.

9.2.6.3

From the drawing space select Region 1. Click the Boundary Condition button to open the 3D
Boundary Conditions dialog.

Select Surface 1 from the Surface drop-down.

Select the point A in the Segment Boundary Conditions Section. From the Boundary Condition
drop down select X Flux Expression.

Enter 0.02 in the Flux expression field.
The X Flux Expression condition is applied from the point A to the point B.
Select the point B. From the Boundary Condition drop down select Zero Flux.

The remaining segments have now been applied the Zero Flux boundary condition.

Important Considerations

The sequence in which regions are drawn can affect how boundary conditions are applied. The methodology
for applying boundary conditions also allows for reasonable variety in how numerical models are constructed.
The following items should be considered, however, when implementing boundary conditions in the software

package.

1.

In 2D, Plan, Axisymmetric, and 3D models only a single segment Boundary Condition can be
applied to any region line segment. If the model contains multiple regions any segment that is on 2
regions can only have a boundary condition set for the segment on one of the regions. Consider
the diagram below, Region 1 and Region 2 are adjacent and both contain the segment AB. If the
Expression boundary condition is set at point B (from B to A) on Region 1 then the boundary
condition set at point A (from A to B) on Region 2 should be specified as No BC. (A Continue
condition would also be acceptable in this case in 2D, but the No BC condition will improve the
solution).
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2. 3D models segment boundary conditions defined on a surface are interpreted as extruding up only
to the next surface. It is important to make this distinction from the way boundary conditions are
applied around a region on a single surface.

3. In 3D models different segment boundary conditions can be applied to a single region on multiple
surfaces. For example, suppose Region 1 has been defined consisting of the points A, B, C, and D
in the counter-clockwise direction. A Zero Flux boundary condition can be defined for the
segment BC on Surface 1 and a Head Expression boundary condition can be defined for the
segment BC on Surface 2.

4. In 3D models segment boundary conditions for any region cannot be defined on the uppermost
surface. There is no layer above the uppermost surface for boundary conditions to be applied to.

9.2.6.4 Copy Boundary Conditions (3D Only)

The copy boundary conditions dialog may be reached by pressing the button on the boundary conditions
dialog when the user is editing a 3-D model. This copy function only applies to sidewall boundary conditions,
not surface boundary conditions. It is provided because sidewall boundary conditions are only applied to one
layer of a model. For example, if the user applies sidewall boundary condition at surface one of a
three-surface model, the boundary condition will extrude up to surface two and apply between surfaces one
and two. If the user wishes the boundary condition to extrude up to surface three then the user must reapply
the boundary condition on the region at surface two.

9.2.6.5 Feature Boundary Conditions Dialog

To define boundary conditions for a feature, select the feature from the drawing space and click on the
Boundary Condition button or select Model > Boundaries from the menu. The feature number is displayed at
the top of the dialog.

Feature boundary conditions are applied in the same manner as region boundary conditions.
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9.2.6.6 Boundary Condition Types

CHEMFLUX provides a list of boundary conditions which may be implemented in a modeling exercise. It is
important to read the comments associated with each boundary condition as not all of them apply in all
situations. A summary of the boundary conditions may be found in the following sections.

It should be noted that the symbol used to represent the boundary condition graphically in the CAD window
will be displayed beside the boundary condition listed in the following sections.

The following boundary conditions are available:

e Continue:

A Continue condition indicates the continuation of the previously defined boundary condition over the
current segment. This is the default condition for all points on a region shape.

e NoBC:

The No BC boundary condition nullifies the effect of any previously assigned boundary condition. Its
primary use is to avoid the situation where there may be duplicate boundary conditions described on an
internal boundary separating two regions. In the description of a 3D model the solver is particularly
sensitive to duplicate boundary conditions being assigned to the same boundary; even if the internal
boundary conditions are exactly the same. Even assignment of a zero flux boundary condition on
adjoining internal boundaries will cause an error. The error may be avoided by specifying a No BC
boundary condition on the particular internal line segment(s) of one of the regions.

e Zero Flux:

The Zero Flux boundary condition restricts the total heat flux along a segment to be zero. If the first
region point is left as Continue, the SVHEAT solver will automatically assume a Zero Flux boundary
condition for it.

It should also be noted that if a Zero Flux boundary condition is specified on an internal boundary
between two regions, the solver will automatically treat the boundary as a normal internal boundary and
allow flux between the regions. To disallow flux to cross an internal part of the model, a small zone of air
must be specified. A Zero Flux boundary condition may be used to “turn off” another boundary condition,
as it is the default condition.

e Concentration
Expression: A

A Concentration Expression boundary condition may take two forms. It may be specified as a constant or
an expression.

If the Concentration Expression will take the form of a constant, a single number will then be entered to
represent a constant concentration flux into or out of the problem. A positive value always indicates flux
into a problem and a negative value indicates flux out of a problem. The units of the concentration
constant are M/L3/T/L. For example, if a concentration rate of 0.2 g/m3/day is applied over a region
boundary 5m in length, the total flow into the problem would be 0.2 x 5 = 1 g/m3/day. It should also be
noted that it is possible to force more solute into the problem than is physically possible using a
concentration boundary condition. In certain cases of unrealistically high concentration boundary
conditions numerical instability will result.

It may be desirable to vary the boundary concentration value with time. This situation can be simulated
with the use of an expression boundary condition. The expression boundary condition could be used to
model a varying concentration rate. Expression boundary conditions may contain any variable defined in
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the CHEMFLUX solver descriptor file. Typical variables that may be used in the boundary condition are

as follows:

Variabl | Description
e

X x coordinate

y |y coordinate

problem

c concentration in current

t time of current problem

Table 1 Common variables used in expression boundary conditions.

The CHEMFLUX solver will also parse the following mathematical functions that may be included in an

expression.

Function Description

ABS(x)

ARCCOS(x) *

ARCSIN(x)

ARCTAN(x)

ATAN2(Y,X) Arctan(y/x)

BESSJ(order,x) Bessel Function J

BESSY/(order,x) Bessel Function Y

COS(x)

COSH(x)

ERF(x) Error Function

ERFC(x) Complementary Error Function

EXP(x)

EXPINT(x) Exponential Integral Ei(x) for real x>0 **

EXPINT(n,x) Exgonential Integral En(x) for n>=0, real
x>0 **

GAMMAF(x) Gamma function for real x>0

GAMMAF(a,x) Incoomplete gamma function for real a>0,
x>

LOG10(x) Base-10 logarithm

LN(x) Natural logarithm

SIN(x)

SINH(x)
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SQRT(x)
TAN(X)

TANH(x)
Table 2 Functions supported by the CHEMFLUX solver (FlexPDE User's Manual, 1999)

* Arguments of trigonometric functions are always in Radians.
** as defined in Abramowitz & Stegun, "Handbook of Mathematical Functions.

One method of applying the expression boundary condition is entering an equation in terms of “t”, for
time. The following equation is an example of a Concentration Expression that was used to simulate a
concentration rate that at time=0 was 2.1E-04 g/m3/s and stopped after twenty-four hours:

-8.75E-06 * t + 2.4E-04

If the model were run for longer than twenty-four hours the boundary condition would be negative and
simulate a suction of the solute out of the ground. The expression could be further modified using
if...then...else logic to control the boundary condition. If...then...else syntax will be interpreted by the
CHEMFLUX solver if it is defined as follows:

if <conditional subexpression> then <subexpression> else <subexpression>

For the above example it would be desirable to use an if statement which set the concentration flux equal
to zero if the time exceeded twenty-four hours. To accomplish this, the following expression may be
entered in CHEMFLUX:

if t <= 24 then -8.75E-06 * t + 2.4E-04 else 0

The THEN or ELSE expression may contain nested IF... THEN...ELSE expressions.
Each ELSE will bind to the nearest IF)

e Flux Expression: O
A Flux Expression boundary condition may take two forms. It may be specified as a constant or an
expression.

In most steady state models the Flux Expression will take the form of a constant. A single number will
then be entered to represent a constant water flux into or out of the model. The units of the flux boundary
are L3/T/ L2. For example, if a flux rate of 0.2 m3/day is applied over a region boundary 5m in length
(and unit width), the total flow into the model would be 0.2 x 5 = 1 m3/day. It should also be noted that it
is possible to force more water into the model than is physically possible using a flux boundary condition.
In certain cases of unrealistically high flux boundary conditions numerical instability will result.

A description of the coordinate system used in the specification of boundary conditions may be seen in
section 8.11.

In transient models it may be desirable to vary the boundary flux value with time. This situation can be
simulated with the use of an expression boundary condition. The expression boundary condition could be
used to model a varying flux rate. Expression boundary conditions may contain any variable defined in
the SVFLUX solver descriptor file. Typical variables that may be used in the boundary condition may be
seen in the Expressions section.
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One method of applying the expression boundary condition is entering an equation in terms of “t”, for
time. The following equation is an example of a Flux Expression that was used to simulate a flux rate that
at time = 0 was 1.5 m"3/day/m”2 (m/day) and at time = 24 it was 3.5 m/day (assuming time is in days):

2*t+15

If the model were run for longer than twenty-four hours the boundary condition would continue to
increase. The expression could be further modified using if...then...else logic to control the boundary
condition. If...then...else syntax will be interpreted by the SVFLUX solver if it is defined as follows:

if <conditional subexpression> then <subexpression> else <subexpression>

For the above example it would be desirable to use an if statement which set the flux equal to zero if the
time exceeded twenty-four hours. To accomplish this, the following expression may be entered in
SVFLUX:

ift<=1then2*t+15else0

SVFLUX also gives you the ability to import flux data. The purpose of this feature is to allow you to use
your electronically gathered precipitation data as a boundary condition. For instruction on using this
feature see Climate Manager.

e Contact/Jump: O

By default, FlexPDE assumes that all variables are continuous across internal material interfaces. A
Contact boundary condition makes a variable discontinuous across this interface. Specifying a CONTACT
boundary condition at an internal boundary causes duplicate mesh nodes to be generated along the
boundary, and to be coupled according to the JUMP boundary condition statement. JUMP is the
difference between the interior and exterior values of the variable.

When a Contact boundary condition is selected from the boundary condition list the Jump[c] statement
will be present by default. The expression can be modified by applying a multiplication factor such as
2*Jump[c] or any other mathematical expressions.

K A Contact/Jump boundary condition can only be applied to an internal boundary.
Tip!
9.2.6.7 Boundary Name

Boundary Names are given to boundary segments to distinguish them for plotting and output. The boundary
name allows the reporting of flux and climate information across the boundary series. If plots and output are
anticipated for a given boundary, be sure to provide a descriptive Boundary Name. Refer to the Plot Manager -
Boundary Flux tab section of this manual for more details.

A boundary name is defined at a specific boundary coordinate. The boundary name applies to the region
segment following this coordinate and continues to apply to subsequent segments until another boundary
name is specified. Whenever a new boundary condition is applied, a default boundary name is automatically
generated. The Boundary Name can be edited by selecting the desired coordinate on the Boundary Conditions
dialog, then by entering a name in the Boundary Name field below it.

Note that Boundary Names cannot be applied if the Boundary Condition type is set as Continue. This indicates
that the previous Boundary Name applies. The exception to this rule occurs if a model is Coupled. In this case
a given coordinate may be Continue in one software package, but be a different boundary condition in the
other software package.
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9.2.6.8 Boundary Conditions Coordinate System

Boundary conditions applied at the edges of a region specify the mass movement in or out of a region. Each
boundary condition implies a unique convention described below.

Head Expression:  Head boundary conditions are always expressed as an elevation in terms of
a y-coordinate in 2D problems and a z-coordinate in 3D problems. There is
no directional distinction as head values are specified in absolute coordinate
terms. Head elevations are specified according to the current global
coordinate system and units specified.

Normal Flux: Positive value of flux are always taken as entering a region and negative
values are always taken as exiting a region. This convention is maintained
irregardless of the direction in which a region is drawn (i.e., clockwise or
counter-clockwise).

X, Y, or Z-Flux: Positive flux values are always taken as entering a region and negative
values are always taken as exiting a region. This convention is maintained
irregardless of the direction in which a region is drawn (i.e., clockwise or
counter-clockwise).

9.2.7 Soils

This section describes the creation of soils in CHEMFLUX. In 2D, Plan, and Axisymmetric problems, each
region must contain a soil. A soil is assigned to a region by choosing its Soil Name in the 2D Regions dialog
or the Region Properties dialog. In 3D the problem consists of region-layer sections. Each of these sections
can have a different soil assigned to it or it can be left as void. The Region Soils dialog is where the soils are
assigned. A database of soils from all projects and problem is maintained and soils can be imported from one
problem to another.

9.2.7.1  Soils Manager

The Soils Manager dialog list all soils which are currently included in the model. It is not a requirement that
soils listed in the Soils Manager are assigned to any particular soil region. This design allows certain amount
of flexibility in which soils are assigned to particular soil regions. The last column displayed in the list of soils
displays to how many regions the current soil is applied.

In the previous version of the software all the soils were stored in the working database. In the latest version
of the software, soils information is stored in each individual XML file located on the hard drive. In order to
maintain consistency between the old and new versions, the import of soil properties from anywhere else in
the project is still provided.

e New...
The purpose of this command is to generate a new soil record. The user is then required to provide a
unique Soil Name.

e Delete
Select the soil and press Delete button. The soil will be deleted from the Soils Manager. The references to
that soil will be removed from any region to which the soil has been applied.

e Properties...
Clicking the Properties... button will bring up the Soil Properties dialog. The Soil Properties dialog will
display a detailed list of the soil properties relevant for the particular material.
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The Soils Manager dialog will remain open while the Soil Properties dialog is open.
Double-click on soils in the Soils Manager to toggle the soil that is displayed in the
Tip! Soil Properties dialog.

e Import...
The Import... but then scans the current modeling directory structure and extracts a list of all slow
properties contained in all XML files. The user may then select soil that they wish to import into the
current model from this list.

Further details may be found under the help for the Import dialog.
9.2.7.1.1 Import

The Soils Database contains all the soils present in all projects and problems in the current
ChemFlux_Data_F.mdb file. To load a soil to the current problem, select it from the list and click Load.
CHEMFLUX will generate a copy of the soil and store it under the current project and problem with a
different Soil Name.

The user may reduce the number of displayed soils by selecting a project he were a bottled it a combo boxes at
the top of the dialog. The displayed list of soils is that restricted to only display soils within that project or
model. the soils in Port dialog will only display soils which have information relevant to the current model.
For example, soils which have stress/deformation information (SVSOLID) will not be listed when importing
soils in SVFLUX.

It should be noted that the software scans all model folders at the time the Import button is pressed. If the user
has a large project folder it is reasonable to expect a slight delay in loading of the soils import dialog.

9.2.7.1.2 Soil Properties Dialog

The following sections describe the information that can be entered as the contaminant transport soil
properties. This dialog is accessed from the Properties button on the Soils Manager dialog.

9.2.7.1.3 Soil Properties Dialog - Dispersion Tab

The dispersion tab requires input of Dispersivity and Diffusion. Dispersivity is required to calculate
Mechanical Dispersion while diffusion is needed to quantify Molecular Diffusion. Combining the affects of
Mechanical Dispersion and Molecular Diffusion results in Hydrodynamic Dispersion.

9.2.7.1.4 Dispersivity

Enter the Longitudinal, o, and Transverse, o components of dispersivity.

K See the CHEMFLUX Theory Manual for more details.
Tip!
9.2.7.1.5 Diffusion
CHEMFLUX requires the input of the effective diffusion coefficient, D" as a constant or function. Input of the

effective diffusion coefficient allows CHEMFLUX to quantify the effects of molecular diffusion.
CHEMFLUX assumes that you have scaled this number to account for tortuosity.

o Diffusion Option
Select either Constant or Function - Laboratory Data as the method of providing D*. Note that the use of
the Function diffusion option requires a specification of the distribution of volumetric water content in the
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modeling domain. The volumetric water content may be specified as a constant or imported from a file
generated by SVFIux. Press the Data button to open the Diffusion Data dialog. vwc vs. D" °data can be
entered.

9.2.7.1.6 Diffusion Data

Enter Volumetric Water Content vs. D* data to define the diffusion curve. The total points entered will be
displayed.

The option to use diffusion curve data is only available if the advection input file contains volumetric water
content.

To paste in Diffusion data:

In the application you are pasting from select the data including the column headings. Use Ctrl + C on the
keyboard to add the data from the other application to the clipboard. Select the first record in the Paste
Diffusion Data dialog list by highlighting the arrow and press Ctrl + V on the keyboard. Click OK to complete
the paste operation.

Graph
Click the Graph button to display a graph of VVolumetric Water Content vs. D*.

9.2.7.1.7 Soil Properties Dialog - Adsorption Tab

e Adsorption Method
There are 4 mutually exclusive isotherm options available for adsorption. The Linear, Langmuir,
Freundlich, and User-Defined.

The Adsorption Method is set on the Settings dialog.

e Linear Isotherm
The linear sorption isotherm models the relationship between the concentration of sorbed and dissolved
solute as a straight line. The linear sorption isotherm requires the input of the Bulk Density (p,) and
distribution coefficient (Kd). The distribution coefficient is equal to the slope of the linear sorption
isotherm Fetter (Fetter, 1993). The main benefit to the linear isotherm is that mathematically, it provides a
stable solution. Be aware that theoretically there is no upper limit on the amount of solute that could sorb
to soil particles. For more information on the formulation of the linear sorption isotherm see Linear
Sorption Isotherm in the Theory Manual.

e Langmuir Isotherm
The Langmuir isotherm is formulated to allow the user the ability to describe an upper limit on the amount
of solute that will be sorbed. The required information is Bulk Density (p,), Binding Energy constant (o
), and a constant describing the maximum amount of solute that can be sorbed (j3).

e Freundlich Isotherm
The non-linear Freundlich isotherm is more general than the linear sorption isotherm and requires Bulk
Density (p), the Freundlich constant (K), and a constant (N). N greater than 1 will lead to a spreading
front, whereas if N is less than 1, the front will be self-sharpening. If N is equal to 1, the Freundlich
isotherm becomes the linear isotherm (Fetter, 1993). It should also be noted that like the linear isotherm
the Freundlich isotherm does not have an upper limit on the amount of solute that could be sorbed. For
more information on the Freundlich sorption isotherm see the Freundlich Isotherm section of the Theory
Manual.
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e User-Defined Isotherm - Laboratory Data
Press the Data button to open the Adsorption Data dialog. Enter Concentration vs. Adsorption data to
define the adsorption curve. The total points entered will be displayed.

To paste in Adsorption curve data:

In the application you are pasting from select the data including the column headings. Use Ctrl + C on the
keyboard to add the data from the other application to the clipboard. Select the first record in the
Adsorption Data dialog list by highlighting the arrow and press Ctrl + V on the keyboard. Click OK to
complete the paste operation.

Graph Adsorption
Click the Graph button to display a graph of Concentration vs. Adsorption.

Graph dC/dS
Click the GraphdC/dS button to display a graph of the derivative of Concentration vs. Adsorption.

9.2.7.1.8 Soil Properties Dialog - Decay Tab

If radionuclides enter the groundwater system, those that are cations are subjected to retardation on soil
surfaces. In addition they will undergo radioactive decay, which will reduce the concentration of
radionuclides in both the dissolved and sorbed phases (Fetter, 1993). Certain biological reactions may cause
half-life for the sorbed radionuclides to differ from the half-life of the dissolved radionuclides. To account for
this CHEMFLUX allows the entry of two separate half-life coefficients, one for the sorbed phase and one for
the dissolved phase.

9.2.7.2  SoilVision Import

The SoilVision Import feature provides easy import of soils data from the SoilVision Database Software.
Steps For Importing

1. Provide the path to a SoilVision Database (SVSoils_Data_F.mdb, SVSoils_MyData_F.mdb, or
SVSoils_Demo_F.mdb)

Select the Search Method.

Refine the search criteria.

Press the Search button. The soils that meet the search criteria will be displayed on the Results tab
Select 1 or more soils in the list.

Press the Graph button to preview the SWCC and Hydraulic Conductivity curves of the data to be
imported.

7. Press the Import button to add the selected soil(s) to the current model.

oakwhn

What data is imported?

The SoilVision database contains a wide variety of soils information including compaction data, compression
data, shear strength data, as well as data related to the hydraulic properties for a particular soil. Imported soil
properties may specifically include:

Porosity: The porosity of the soil selected in the SoilVision database will be imported.
Specifically, the porosity displayed in the Porosity field on the Volume-Mass
tab of the Soils form will be imported.

Specific Gravity: The specific gravity of the currently selected soil will be imported if the data is
present in the SoilVision database. Importing the specific gravity allows the
user to contour volume-mass relationships during the solution process in
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SVFlux.

SWCC: The laboratory data in terms of volumetric water content versus soil suction
will be imported. The gravimetric water content stored in SoilVision will be
converted to volumetric water content assuming zero volume change during
the tempe cell test. Appropriate unit conversions to ensure data is compatible
with the units selected for the current model will be performed during the
import process.

Note: the current import routine only supports importing of the drying soil-
water characteristic curve.

ksat: If a Laboratory ksat value is present for the current soil then it will be
imported. Appropriate unit conversions to ensure data is compatible with the
units selected for the current model will be performed during the import
process.

kunsat: If the Laboratory Drying Kunsat data is present for the currently selected soil
then it will be imported. This data, if present, would be displayed in the
Unsaturated Permeability form in SoilVision. Appropriate unit conversions to
ensure data is compatible with the units selected for the current model will be
performed during the import process.

Database Path

By pressing the browse button the user may specify the path to a valid SoilVision database file. (default
c:\svs\soilvision\data) Only the most recent SoilVision database files are supported which specifically include
databases for version 4.x of the SoilVision software. The valid databases are tagged with the letter "F" at the
end of their name. Valid filenames include one of the following files:

SVSoils_Data_F.mdb: This database file typically needs a SoilVision database distributed with our
software. It contains soil-water characteristic curve data on over 6000 soils.
Also included in this database are over 2500 laboratory measured saturated
hydraulic conductivity values as well as over 600 measured unsaturated
hydraulic conductivity curves.

SVSoils_Demo_F.mdb: While it is possible to import soils from the demo database is not
recommended. The demo database is distributed containing fictitious soils
information whose primary purpose is to demonstrate the features of the
SoilVision software.

SVSoils_MyData_F.mdb: The "MyData" database is distributed with the SoilVision product as a
blank database to which the user can add their own soils data. If the user has
used the SoilVision product to build up their own database then the desired
data is likely to be contained in this database.

Default Search Criteria
In addition to the Search Method explained below, the Search will only display soils that have SWCC data
and Volume-Mass parameters calculated.

Search Method

Valid search methods include searching for soils by texture, grain size properties, or a specific soil indicator
such as the soil name or soil index. Further information related to searching by each method may be found in
the table below.

Texture (USDA): In this search method the user searches for soils based on their United States
Department of Agriculture (USDA) classification. The specific divisions
between clay, silt, and sand-sized particles which are used by the USDA are
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Texture (USCS):

Grain Size (USDA):

Grain Size (USCS):

Soil Name:

Soil Counter:

Include Kunsat Data

outlined SoilVision documentation. The majority of the soils in the
SoilVision database were obtained from government-run soil science
divisions. therefore there are a high percentage of the soils which include
USDA textural classification.

Texture Like: If the user selects to search by this textural classification then
they must select a valid USDA texture from the Texture Like combo box. A
list of valid USDA textures is provided from which the user may select.

The Unified Soil Classification System (USCS) is the primary classification
system used by geotechnical engineers in North America. The primary
limitation of searching within the SoilVision database using this classification
method is that it requires Atterberg limits to properly classify many soils.
Atterberg limit information is not present for the majority of the soils in the
SoilVision database. It is therefore recommend that this search method only be
used with data which has been entered into SoilVision via the user and which
has Atterberg Limit data present.

The specific divisions between clay, silt, and sand-sized particles which are
used by the USCS classification system are outlined SoilVision
documentation.

Texture Like: If the user selects to search by this textural classification then
they must select a valid USCS texture from the Texture Like combo box. A list
of valid USCS textures is provided from which the user may select.

Soils within SoilVision may be selected based on their grain-size properties.
Using this option the user may import soils which have more than 20% clays,
for example. It should be noted that percentages should be entered as decimal
values. For example, 30% should be entered as 0.3 on the dialog.

The specific divisions between clay, silt, and sand-sized particles which are
used by the USDA classification system are outlined SoilVision
documentation.

Soils within SoilVision may be selected based on their grain-size properties.
Using this option the user may import soils which have more than 20% clays,
for example. It should be noted that percentages should be entered as decimal
values. For example, 30% should be entered as 0.3 on the dialog.

The specific divisions between clay, silt, and sand-sized particles which are
used by the USCS classification system are outlined SoilVision
documentation.

The Soil Name is specified at the top of the Soils form within SoilVision
database. If part of the Soil Name is selected then all variations of the soil
name will be selected for import. For example, if "Silt" is selected then all
soils which include the word "Silt" in any part of the Soil Name field will be
selected in the search.

The Soil Counter field is the primary index used by the SoilVision software to
unique the identify each soil. The Soil Counter is displayed in the upper right
corner of the Soils form within the SoilVision software.

Clicking the Include Kunsat Data check box will restrict the search to only soils in the database which contain
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measured unsaturated hydraulic conductivity curve information.

9.2.7.3 Region Soils Dialog

Soils are assigned in 3D problems using the Region Soils dialog. To access the Region Soils dialog click the
Region Soils button in the Header of the Workspace or select Model > Soils > Region Soils from the menu.

Using this dialog soils are set by region. The dialog is opened to the region that is in the region selector. Each
region will cut through all the layers in a problem creating a separate “block” on each layer. Each block can be
assigned a soil or be left as void. The Region Soils dialog lists each layer in the problem and the surfaces that
bind it. To assign a soil, select its Soil Name from the drop-down. If the drop-down is left blank the layer will
be void over the current region.

9.2.8 Reporting

The Model > Reporting menu options control the output which is displayed by the FlexPDE finite element
solver. Many finite element packages are created on a "black box" concept by which the user is never allowed
to see what is going on in the solver. Almost any type of reporting can be created in the finite element solver
and viewed while the solver is solving! This transparent approach of our numerical modeling software allows
much greater understanding by the end user as far as what is going on in the numerical model during model
solution.

Viewing finite element computational results also allows the user an additional check on model validity. It is
possible that a finite element numerical model may be run in which the results look reasonable but the
computational results are invalid. An example of this is the computing of 1D coupled surface-flow results.
Results can often be obtained which look reasonable but if the user plots water gradients in the y-direction it
can be seen that a lack of nodal resolution is producing numerically unstable gradients.

The output from the FlexPDE solver is divided into several types which may be seen in the following sections.
In particular the functionality of the i) Plot Manager, ii) the Output Manager, and iii) the Flux Sections are
covered.

9.2.8.1 Plot Manager

The Plot Manager controls the specification of all plots and monitors generated and displayed during model
solution. The functionality of the Plot Manager has been greatly improved for the release of SVOffice 2006. In
particular all plots generated by the FlexPDE solver may be only specified in the Plot Manager. This
centralization of plot controls simplifies program operation and allows the user greater control over the
visualization of finite element results they want to see.

The foundational principle for the new concept of the Plot Manager is that each line entry represents a single
plot to be generated. Multiple plots may be grouped together through the use of the Group function.

Select Model > Plot Manager from the menu to open the Plot Manager dialog.

There are 7 different plot types that can be defined with the Plot Manager that will be presented by the solver.
The buttons on the bottom left of each tab on the dialog control the plot type. They are Contour, Elevation,
Vector, Surface, Mesh, Report, and History.

There are various tabs on the Plot Manager that allow the addition of specific types of plots. Some tabs are
software dependent and will only appear if modeling in that software, while other tabs will be available
depending on other model settings, such as Model System and Model Type. Each tab is described in more
detail in the following sections.

In some cases, by default, certain plots are generated for the model when the model is created. (These entries



SOILVISION SYSTEMS, LTD. Menu System 72 of 108

may be deleted or modified in the same manner as any other plot)

Adding Plots

Click the button for the type of plot to add. The Plot Properties dialog will open with the appropriate
fields enabled for the selected plot type. Provide the desired information in the fields. Not all fields are
required. When the plot definition is completed it will be displayed in the plot manager dialog.

Editing Plots
Select the plot from the list and double-click or press the Properties button to open the Plot Properties
dialog.

Deleting Plots
Select the plot from the list and press the Delete button to remove it from the model.

Multiple Update
Click the Multiple Update button to open the Multiple Update dialog.

Plot Settings
Press the Settings button to open the Plot Settings dialog. The settings on this dialog apply to all plots in
the model.

Custom Plots
Press the Custom Plots button to open the Custom Plots dialog.

Add Default Plots

Press the Add Default Plots button to open add the default plots to the model. The default plots are those
suggested by SoilVision Systems for basic modeling. The plots that are added will depend on the software,
model system, model type, and other settings. If default plots are already present a choice will be given to
accept or decline addition of new plots. (These entries may be deleted or modified in the same manner as
any other plot)

9.2.8.1.1 Plot Types

The plot types available on the various tabs of the Plot Manager are described below:

Contour
This plot creates a two dimensional contour map of the variable. Contour levels are automatically selected.

Elevation
The Elevation plot will plot the selected variable over a selected range. The variable on the vertical axis
and the distance on the horizontal axis.

Range
Required entry. The range consists of a start point and an end point. This will be the range for the
horizontal axis on the plot. Be sure that the start point and end point are within the geometry of the
model.

Select Range
Use the Select Range button to select a range in the CAD Window with the mouse.

Generate Elevation Text File
Optional entry. Generates an ASCII text file of the elevation plot data. The file is written to the solution
files directory with this format: Title.pgl, where the extension number will increment depending on how
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many files are being generated for this run. Choose one of the file formats from the Format drop-down
box.

The Elevation Text File is useful for importing the data into spreadsheet applications
for data manipulation, compilation, and plotting of multiple variables on the same
Tip! chart

e Vector
A two dimensional display of directed arrows in which the direction and magnitude of the arrows is
controlled by the model gradients. The origin of the arrow is placed at the reference point.

e Surface
A quasi three dimensional surface which displays the value of the variable vertically. A Surface plot is not
as meaningful in two-dimensional analysis and it is recommended that this plot be used only in
three-dimensional models.

e Mesh
The Mesh plot will display the finite element mesh.

e Report
The report is used to report the value of the selected variable. Multiple items may be reported on the same
plot. Select a variable from the list then choose to restrict it to a region or layer if desired.

e History
The history plots are used to report the value of the chosen variable vs. time at a specified point. Multiple
points may be plotted on the same axes.

Points Tab
Enter the points in the model where the variable is to be reported.

Generate History Text File

Optional entry. Generates an ASCII text file of the history plot data. The file is written to the solution files
directory with this format: Title.pgl, where the extension number will increment depending on how many
files are being generated for this run. Choose one of the file formats from the Format drop-down box.

The History Text File is useful for importing the data into spreadsheet
applications for data manipulation, compilation, and plotting of multiple
Tip ! variables on the same chart.

9.2.8.1.2 Plots Tab

The Plot tab lists all currently defined plots in the general Plots category. Plots are low-quality plots used to
visualize variables involved in the current finite element analysis. High-quality visualizations may be created
by creating an AcuMesh DAT file and opening the file in AcuMesh. The DAT file may be created using the
Output Manager.

On this tab the plots may be of the type Contour, Elevation, Vector, Surface, or Mesh. These plot types are
described in more detail in the previous Plot Types section.
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9.2.8.1.3 Points Tab

The Points tab is for the creation of plots which report variable values at a point within the model geometry.
Reports or History plots may be created.

Reports allow the reporting of a particular value at a specific point. The value presented in the report is always
the value at the most recent stage or time-step at which a value is requested.

History plots allow the creation of a graph of a particular value as a function of time. These types of plots are
particularly useful in the analysis of transient models where model variables are changing with time.

The specific location at which plot coordinates the model variables are reported may be specified using the
CAD control. Any variable involved in the current analysis may be reported or plotted. The software will
provide a warning if a variable cannot be plotted due to various model settings.

The specifics of the properties for each report or history plot may be found in the Plot Properties Dialog
section.

9.2.8.1.4 Area/Volume Tab

On the Area/VVolume tab a report or history plot is used to display the volume of the model, and/or the area of
the model, the volume of water, as well as the frozen and unfrozen water volumes. Multiple items may be
reported on the same plot.

9.2.8.1.5 Flux Sections Tab

On the Flux Sections tab a report or history plot is used to display the flow across the chosen flux section.
Multiple items may be reported on the same plot. A Flux Section must first be defined before any flux section
plots can be defined. See the Flux Reporting section of this manual.

On the Plot Properties tab these settings are of interest:

e Restrict Report to Layer
This option is available in 3D only. Choose a Layer to report the flow through. 3D extruded flux sections
default to reporting the flow across all layers.

¢ Restrict Report to Region
Extruded flux sections report the flux over all regions that they intersect by default. To report only for a
specific region choose it from the drop-down. In 3D if the flux section is restricted to a region it must also
be restricted to a Layer.

9.2.8.1.6 Boundary Flux Tab

On the Boundary Flux tab a report or history plot is used to display the flow across the chosen boundary.
Multiple items may be reported on the same plot. A Boundary Flux plot requires a Boundary Name to be
specified for a region segment or series of segments. Boundary Names are set on the Boundary Conditions
dialog.

On the Plot Properties dialog the desired Boundary Name can be chosen from the Boundary drop-down. The
various components of flow can be selected from the Variable list. The variables can be chosen in either
Volume per time units ("Flow") or Volume units ("Cumulative Flow").

Plots of the same units can be shown in the same window by adding them to the same Group on the Output
Options tab.
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9.2.8.1.7 Surface Flux Tab

On the Surface Flux tab a report or history plot is used to display the flow across the chosen surface. Multiple
items may be reported on the same plot.

9.2.8.1.8 Review Boundary

On the Review Boundary tab a report or history plot is used to display the exit point of the water table on the
chosen boundary. Multiple items may be reported on the same plot. A Review Boundary plot requires a review
Boundary, and subsequently a Boundary Name to be specified for a region segment or series of segments.
Review boundary conditions are set on the Boundary Conditions dialog.

On the Plot Properties dialog the desired Boundary Name can be chosen from the Boundary drop-down.
9.2.8.1.9 Climate Tab

On the Climate tab a report or history plot is used to display the various variables associated with a climate
boundary condition. Multiple items may be reported on the same plot. A Climate plot requires a Climate
boundary condition, and subsequently a Boundary Name to be specified for a region segment or series of
segments.

Climate boundary conditions are set on the Boundary Conditions dialog. When a climate boundary condition
is assigned, history plot entries for the most common variables, such as precipitation, runoff, potential
evaporation, actual evaporation, and boundary flux, will be added by default. These plots can be modified or
deleted as any other plots can, as well, new plots can be added.

On the Plot Properties dialog the desired Boundary Name can be chosen from the Boundary drop-down.
Various climate related variables are available in the variable drop-down.

9.2.8.1.10 Global Climate Tab

On the Global Climate tab a report or history plot is used to display the various variables that are not
associated with a climate boundary condition, but that are global to the model if evaporative boundary
conditions are applied. Multiple items may be reported on the same plot. A Global Climate plot requires at
least 1 Climate boundary condition to be applied.

Climate boundary conditions are set on the Boundary Conditions dialog. When a climate boundary condition
is assigned, history plot entries for the most common variables, such as precipitation, runoff, potential
evaporation, actual evaporation, and boundary flux, will be added by default. These plots can be modified or
deleted as any other plots can, as well, new plots can be added.

On the Plot Properties dialog various climate related variables are available in the variable drop-down.
9.2.8.1.11 Other Tab

The Other tab lists plots that are generated automatically on model creation and are generally unique compared
to the entries on the other tabs. For example, an entry for Model Properties is listed. This entry will cause the
solver to display general information about the model in a report window. This report can be turned off by
un-checking the PLOT and MONITOR options on the Output tab of the Plot Properties dialog.

9.2.8.1.12 Plot Properties Dialog

Using the Plot Properties dialog plot names, variables, time intervals, zooming, and other plot modifiers can

be defined. Depending on the type of plot chosen and other model settings such as system and type, different
tabs and fields will be available.

Refer to the following sections for more details on the required information for each tab.
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9.2.8.1.12.1 Description Tab

e Title
The title will be displayed as the plot window title in the solver. If no title is provided the solver will
display the variable as the title.

e Variable
The Variable drop down provides a selection of the variables available for each type of plot. The
drop-down lists the units and a description of each variable. Select the variable to plot. Most plot types
require the entry of a variable. Certain variables listed may not be available for the current model due to
model settings such as system or type, or if certain soil information has not been provided, for example.

e Restrict to Region
The Restrict to Region drop down will restrict the plot to the region that is selected. The variable will only
be plotted over this region in the solver window.

e Restrict to Layer
The Restrict to Layer drop down will restrict the plot to the layer that is selected. The variable will only be
plotted on this layer. (Available in 3D only)

e Display Limits
The minimum and maximum display limits will cause the graph or report to only display values in this
range. Take caution when using these options as the actual values calculated may fall outside this range.
This feature is useful for examining a certain value range in more detail that may be overshadowed by
spikes in the data.

9.2.8.1.12.2 Range Tab

The Range tab is specific the the Elevation plot type. On the Range tab the start and end coordinates over
which a value is to be plotted can be specified. These values can either be entered manually or selected in the
Workspace using the mouse.

In 1D models, the option to set the range to extents of the geometry is available by pressing the Entire Range
button.

9.2.8.1.12.3 Points Tab

The Points tab allows the specification of points within the model for which model variables may be reported.
The Points tab becomes available when defining plots on the Points tab. An unlimited number of points may
be specified as either coordinates which are typed in using the keyboard or selected using the mouse on the
CAD canvas. Pressing the Select Points On Canvas button will allow the user to click directly on the canvas in
order to specify reporting locations. All values specified will be reported on the same plot.

The Delete, Delete All, Insert Point, and Paste Points function are operations which may be performed on the
list of points specified in the points list control.

9.2.8.1.12.4 Projection Tab

The Projection tab is available for 3D plots. For individual plot types 1 or more of the projections options will
be available.

e Plane Option
Set the 2D plane on which to plot the variable. Select a coordinate direction (X, Y, or Z) and specify a
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coordinate value. For example, a X = 30 specification will display the variable in the YZ-plane cut
through X = 30.

e Surface Option
This option will display the chosen variable’s value over the selected surface projected onto the XY-plane.

e Equation Option
Provide an equation for the plot surface in terms of the coordinate variables and solver functions.

e 3D Option
Available for mesh plots. A 3D mesh plot will be generated.

Use a feature at the same coordinate plane as specified for a 3D plot to improve the
plot resolution. Solution mesh element edges are forced to features; thus a cleaner
Tip! plotcanbe generated as well.

9.2.8.1.12.5 Zoom Tab

Use the Zoom feature to focus the plot on a certain area. Supply a Zoom Origin and Zoom Window
dimensions. Use the Select Zoom button to select an XY-plane plane (or RZ-plane in Axisymmetric) zoom
area in the CAD Window with the mouse.

9.2.8.1.12.6 Update Method Tab

e Update Option
The plot output can be updated by either time or the solver cycle.

e Time Steps
The Start, Increment, and End plot times can be different than the model time, which is provided for
reference. Use the arrow to quickly put the Model Time values in the Plot Time fields. Only the Start time
for the plot is required. If this is the case the solver will only report the plot at the specified time.

e Cycle
Provide the cycle interval for updating the plot. This option is useful in examining the model when the
time-steps are very small to determine if the model is achieving stability.

9.2.8.1.12.7 Output Options Tab

e Output Options
If PLOT is selected the plot will be displayed while the solver is running and remain open when the
solution is obtained. It will also be stored in the .PG5 file generated by the solver.

If MONITOR is selected the plot will be available while the model is running, but not after the run is
completed and it will not be written to the .PG5 file.

o .txt File
Some plots can have the plot data output to a text file for further study or import into various other
application. Select the Write To .txt File box to have the solver generate the file. A number of
comma-separated variable orders can be chosen using the File Format drop-down.

Select the Merge Time Steps To Single .txt File option to output data for all stages or time steps to a single
xt file.

o Display Group
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The Group option provides the ability to group various graphs of the same unit type on the same plot
window. The Group drop-down box will initially be blank. Once one group name has been provided it will
be available for other plots in the model.

9.2.8.1.13 Multiple Update

The Multiple Update dialog allows updating of multiple plot properties at one time. The options set in the
Multiple Update dialog apply to the plots currently selected when the Multiple Update dialog is opened.

Update Method: This tab sets the time steps or cycle when the plot will be refreshed for the selected plots.

Output Options: This group box allows the user to set the selected plots to either type PLOT or MONITOR
or both.

Display Group: This group allows the grouping of individual plots onto the same single plot. This function
is useful if similar values are being generated which are more easily visualized when combined on a single
graph. An example of this might be combining the history of water volume integrals for several regions on a
single graph.

9.2.8.1.14 Plot Settings

The settings included in this dialog will apply to all relevant plots specified for a model. Access this dialog by
pressing the Settings button on the Plots dialog

Press Reset to restore the default settings.

The following descriptions relate to switches used to allow control over the FlexPDE solver plot output.
Description of these switches has been taken from the user’s manual of FlexPDE. Please see the
documentation distributed with FlexPDE for further explanation regarding the use of these parameters.

Color Tab
These plot settings relate to setting the colors of plots generated by FlexPDE.

BLACK default: Off
Draw all graphic output in black only.

GRAY default: Off
Draws all plots with a gray scale instead of the default color palette.

PAINTED default: Off
Draw color-filled contour plots. Plots can be painted individually by selecting PAINT in the plot
modifiers.

PAINTREGIONS  default: Off
Sets PAINTGRID, but selects a different coloring scheme. Colors represent logical regions in 2D, or
logical (region,layer) compartments in 3D, instead of distinct material parameters.

THERMAL_COLORS  default: On
Sets the order of colors used in labeling plots. ON puts red is at the top (hot). OFF puts red at the bottom
(lowest spectral color).

Display Tab
The settings on this tab relate to the general display settings of FlexPDE

ALIAS (coord) ="name" default: Coordinate name
Defines an alternate label for the plot axes.
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FONT default: 2
Font=1 selects sans-serif font. Font=2 selects serif font.

TEXTSIZE default: 35
Controls size of text on plot output. Value is number of lines per page, so larger numbers mean smaller
text. Previous versions used 30.

FEATUREPLOT default: Off
If this selector is ON, FEATURE boundaries will be plotted in gray. This was the default behavior in
versions prior to 3.10b.

NOMINMAX default: Off
Deletes "0™" and "x" marks at min and max values on all contour plots.

NOTAGS default: Off
Suppresses level identifying tags on all contour and elevation plots.

NOTIPS default: Off
Plot arrows in vector plots without arrowheads. Useful for bi-directional stress plots.

Resolution Tab
The resolution tab generally relates to the amount of detail displayed in plots generated by FlexPDE.

CONTOURS default: 15
Target number of contour levels. Contours are selected to give "nice™ numbers, and the number of
contours may not be exactly as specified here.

LOGLIMIT default: 15

The range of data in logarithmic plots is limited to LOGLIMIT decades below the maximum data value.
This is a global control which may be overridden by the local LOG(number) qualifier on the plot
command.

CONTOURGRID  default: 51
Resolution specification for contour plots. Actual computation cell sizes will be used unless they exceed
the size implied by this resolution.

ELEVATIONGRID  default: 401
Elevation plot grid size used by From..To elevation plots. Elevations on boundaries ignore this number
and use the actual mesh points.

SURFACEGRID default: 51
Selects the minimum resolution for Surface plots.

VECTORGRID default: 31
Sets minimum resolution of Vector plots.

Magnification Factor default =1
This setting is available in SVSolid and can be applied to plots of deformed mesh.

Surface Plot Tab
This tab refers to settings related to surface plots generated by FlexPDE.

VIEWPOINT (X, Y, angle) default: negative X&Y, 30
Defines default viewpoint for SURFACE plots. Angle is in degrees. (In 3D, this specifies a position in the
cut plane)
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VIEWPOINTANGLE default: 30 degrees
Defines the default viewing perspective inclination of surface plots.

Other Tab
Other miscellaneous FlexPDE plot settings

HARDMONITOR  default: Off
Causes MONITORS to be written to the hardcopy (.pg5) file.

PRINTMERGE default: Off

Send all stages times of each EXPORT statement to a single file. By default, EXPORTS create a separate
file for each time or stage. Individual EXPORTS can be controlled by plot modifiers. NOT AVAILABLE
IN SVOFFICE 2006, use the Merge Time Steps To Single .txt File option on the Plot Properties dialog.

AUTOHIST default: On
Causes history plots to be updated when any other plot is drawn.

MERGE default: On
Allows merging of low-error mesh cells. Only cells which have previously been split can be merged.

PLOTINTEGRATE  default: On
Integrate all spatial plots. Default is volume and surface integrals, using 2*pi*r weighting in cylindrical
geometry. Histories are not automatically integrated, and must be explicitly integrated.

Reset Button
The reset button sets all settings on the plot dialog to the factory default settings. Any user-made adjustments
will be lost.

9.2.8.1.15 Custom Plots

Use the Custom Plots dialog to add any desired custom plot specification or to quickly add plots by cutting
and pasting from a previously generated .pde file.

Access the Custom Plots dialog by clicking the Custom button on the Plot Manager dialog.

Enter the desired plot specification in the appropriate solver file format then check the PLOT or MONITOR
box.

9.2.8.2 Output Files

Output Files are defined similar to the way plots are defined. The Output Files dialog specifies all file types in
which finite element information is written out from the solver during a finite element analysis. All output files
are written to the solution files directory adjacent to the <ProjectID>_<Model Name>.pde file.

9.2.8.2.1 Output Manager Dialog
Select Model > Output Manager from the menu to open the Output Manager dialog.
There are a number of different output types that can be defined with the CHEMFLUX Output Manager that

will be written by the solver. The buttons on the bottom left of the dialog control the output type.
Sequentially they are Table, Transfer, and AcuMesh.

e Adding Output Files
Click the button for the type of output to add. The Output File Properties dialog will open with the
appropriate fields enabled for the selected output type. Provide the desired information in the fields. Not
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all fields are required. When the output file definition is completed it will be displayed in the output
manager dialog.

e Editing Output Files
Select the output file from the list and double-click or press the Properties button to open the Output File
Properties dialog.

e Deleting Output files
Select the output file from the list and press the Delete button to remove it from the model.

9.2.8.2.2 Output File Properties Dialog

Using the Output File Properties dialog output file names, variables, time intervals, zooming, and other output
file modifiers can be defined. Depending on the type of output file chosen, the model system, model type, and
other settings, different tabs and fields will be available.

9.2.8.2.2.1 Description Tab

e File Name
All output definitions require a file name. The file that will be written out will be the name provided
followed by the extension for the output file type.

e Variables
Single or multiple variables can be included in the same output file. Enter the variables using a comma to
separate them.

e Variable List
Select the variables from the list and then press the Add Selection button to add the selected variables to
the Variables field. Hold the Shift or Ctrl keys to select multiple variables with the mouse.

e Restrict to Region
The Restrict to Region drop down will restrict the output to the region that is selected. The variable will
only be output over this region. (Only available for Table file type)

In transient models a file will be written for each time step. This can quickly fill up
hard drive space.
Tip!

9.2.8.2.2.2 Update Method Tab

e Update Option
The output file data can be updated by either time or the solver cycle.

e Time Steps
The Start, Increment, and End times can be different than the model time, which is provided for reference.
Use the arrow to quickly put the Model Time values in the Plot Time fields. Only the Start time for the
output file is required. If this is the case the solver will only report the plot at the specified time.

Setting the output file Start time to the model end time will cause the output to only
be written at the end of the solution. This will save disk space and allow the solution
Tip! tobecompleted faster.

e Cycle
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Provide the cycle interval for updating the output file.

9.2.8.2.2.3 Output Options Tab

o Write File
If Write File is selected the output file will be written out by the solver.

9.2.8.2.2.4 Grid Lines Tab

If a Table output file is being specified this tab will be available. Enter the number of grid lines in each
direction to output data on.

9.2.8.2.3 Output File Types

The output file types may be written out by the FlexPDE finite element solver at any point in the analysis. The
output file types typically contain information over the entire finite element domain. Certain options allow
restriction of this output. The output generated from the Output Manager is typically read into AcuMesh for
advanced visualization or used as initial conditions for subsequent analysis.

e AcuMesh
Use AcuMesh to write variables to a file that is readable by the AcuMesh software. To open the file in
AcuMesh, use the Send To AcuMesh option from the Solve menu once FlexPDE has completed the
analysis. Any number of current model variables may be written to the .DAT file.

Multiple time steps in a transient analysis can be recorded in this file format. It should therefore be noted
that for large 3D analysis this file can grow to be quite large. In a transient analysis it is not recommended
that more than approximately 20 time steps be written out to this file unless the mesh is relatively simple.

e Table
The Table file format writes variables interpolated on a rectangular grid to a text file.

It should be noted that a table file contains defined variable values at the intersection points of a
rectangular grid. This method introduces two interpolations of finite element data; i) the first one when the
.TBL file is exported, and ii) the second interpolation when the imported table values are mapped onto the
current finite element grid. Due to these potential sources of errors it is recommended that end users make
use of the transfer file ( TRN) whenever possible.

TABLE data are interpolated with linear, bilinear or trilinear interpolation on the specified data grid.

Each table file can only hold one time step in a transient analysis. In a transient analysis, the output will be
written to a file "<model>_<sequence>.tbl" where each time step or stage will create a separate file.

The Gridlines tab allows the user to set the number of grid lines on which the data will be exported. It is
only possible to export values on even intervals in the X, y, or z direction using a table file.

e Transfer
Use the Transfer plots to write variables to a text file of . TRN format. This method of data transfer
between FlexPDE models retains the full accuracy of the computation, without the error introduced by the
rectangular mesh of the TABLE function (.TBL files). The exported mesh is the actual computational
mesh so all material interfaces are preserved.

Each transfer file can only hold one time step in a transient analysis. In a transient analysis, the output will
be written to a file "<model>_<sequence>.trn" where each time step or stage will create a separate file.

The primary use of transfer files is to export values of a certain analysis for later import as initial
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conditions for a subsequent analysis. Care should be taken to export only needed variables as transfer files
can become quite large if a fine mesh spacing is used in the analysis.

9.2.8.2.4 Output Settings Dialog

The settings included in this dialog will apply to all relevant output files specified for a model. Access this
dialog by pressing the Settings button on the Output Manager dialog.

Press Reset to restore the default settings.

The following descriptions relate to switches used to allow control over the FlexPDE solver output files.
Description of these switches has been taken from the user's manual of FlexPDE version 5.0. Please see the
documentation distributed with FlexPDE for further explanation regarding the use of these parameters.

o Alphabetical Listing of Output Settings Fields
The following finite element options are listed in alphabetical order and are taken from the FlexPDE user’
s manual version 5.0. The defaults listed are applicable for version 5.0 of FlexPDE.

FINDERBINS default: 20

FlexPDE uses a banded subdivision of the box containing the domain to speed the search for plot points in
the computation mesh and lookup points in TRANSFER files. In models with meshes which are dense in
localized areas, the default of 20 bands may be insufficient to speed the lookup, and a larger number of
bands may be required. Use FINDERBINS to select a new number.

e Region Separation
Causes separation of regions into distinct areas for output independent of soil properties. In 3D separate
region-layer blocks are created. This switch is useful when creating output for use in AcuMesh and for the
Soil Properties Verification feature. The Region Separation option is defaulted to ON.

9.2.8.2.5 Custom Output Files

Use the Custom Output Files dialog to add any desired custom output file specification or to quickly add
output files by cutting and pasting from a previously generated .pde file.

Access the Custom Output Files dialog by clicking the Custom button on the Output Manager dialog. Enter
the desired output file specification in the appropriate solver file format then check the Write File box.

9.2.8.2.6 Multiple Update

The Multiple Update dialog allows the user to change the properties of a group of output files at one time.
This dialog is of use if, for example, the user wants to update the time at which a group of output files are
updated. Only certain properties may be updated using Multiple Update dialog.

9.2.8.3 Flux Reporting

Flux sections are used to report mass of solute moving across a portion of the problem. There are three types
of Flux Sections. The Extruded flux sections are drawn as lines across a problem and report the mass through
a plane while Surface flux sections report the mass through a surface in 3D problems. Finally, Boundary Flux
definitions are used to report the mass flux across a material boundary. The advective and dispersive
components can be reported along with the combined mass flux (advective + dispersive).
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9.2.8.3.1 Extruded Flux Sections

Extruded flux sections appear as blue lines with arrowheads in the workspace. Each Flux Section is given a
label that corresponds to the order that it was added to the problem. CHEMFLUX allows the definition of as
many flux sections as needed.

Extruded flux sections are drawn on the region that is current in the region selector, but act independent of
regions. They will report the mass flux for any portion of a region that they overlap. In 3D problems the flux
sections extend through all layers.

Aux2

i

Hux1

An extruded flux section must not go outside the geometry of the problem. If the
flux section is drawn outside the geometry, the CHEMFLUX solver will not be able
Tip! toprovide asolution for the mass flux.

e Adding Extruded Flux Sections
Instructions for adding an extruded flux section with the mouse:

1. From the region selector, select the region the feature will be drawn on.

2. Click the Flux Section button in the toolbar or select Draw > Flux Section from the menu to
enable the draw crosshairs.

3. Draw the first point in the workspace.

4. Click the workspace again to specify the end point and finish the flux section.

Instructions for adding an extruded flux section in the command line. When entering coordinates in the
command line, the format is the X coordinate, followed by a comma and the Y coordinate. When on the
last point of a flux section enter the letter “f” to finish the flux section.

1. From the region selector, select the region the flux section will be drawn on.

Click the Flux Section button in the toolbar or select Draw > Flux Section from the menu to
enable the command line.

Enter the first coordinate point for the flux section.

Press the Enter key.

Enter the second point.

Press the Enter key to complete the flux section.

N
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e Flux Section Reporting
The CHEMFLUX solver will generate a report for each flux section defined. The advective and dispersive
components are reported along with the combined mass flux (advective + dispersive). The X and Y
components of mass flux are reported as well as the normal flow component.

Coordinate System

Flux section values are reported as components in each dimension as well as a total normal flow value.
The X, Y, and Z components will adhere to the coordinate system for the entire problem. For example, in
a 2D problem positive flow in the X direction is to the right and positive Y flow is up. Total normal flow
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is the absolute flow crossing the flux section and is independent of the coordinate system.

Units

CHEMFLUX will report the Instantaneous Mass Flux as well as the total cumulative Mass Flux across the
flux section for the duration of the problem. The instantaneous mass flux value is reported in units of M/T
and represents the mass flux at the reported time. Total mass flux is presented in units of M and represents
the total mass flux passing the flux section since the start time specified in the flux section properties
dialog. For example, if the user is working in g and days, the flux section value will be presented in units
of g/day. It should also be noted that the value reported represents the mass flux across the entire length of
the flux section.

9.2.8.3.2 Flux Sections Dialog

The Flux Sections dialog is opened by selecting Model > Flux Sections from the menu.

Extruded Tab

The extruded flux sections are listed on the first tab of the Flux Sections dialog. When a flux sections is
added to the problem it is assigned an incremental flux section number and its title is defaulted to “Flux
#.

Select a flux section from the list and press the Properties button to open the Flux Section Properties
dialog or press Delete to remove the flux section from the problem.

Use the Set All Times button to open the Set All Problem Flux Section Times dialog.

Surface Tab
See the Surface Flux Sections section.

9.2.8.3.3 Flux Section Properties Dialog

To open the Flux Section Properties dialog select a flux section in the workspace and click the Properties
button or use the Edit > Object Properties menu. Alternately this dialog can be opened from the Flux Sections
dialog.

The top section of the Flux Section Properties Dialog displays the flux section number and the region it is
drawn on and provides options for restricting the flux section report.

Restrict Report to Layer
This option is available in 3D only. Choose a Layer to report the flow through. 3D extruded flux sections
default to reporting the flow across all layers.

Restrict Report to Region

Extruded flux sections report the flux over all regions that they intersect by default. To report only for a
specific region choose it from the drop-down. In 3D if the flux section is restricted to a region it must also
be restricted to a Layer.

Editing a Flux Section

Each flux section is given a default label of the dialog “Flux #”. The label text, format, and position can be
modified. Press the Edit button to open the Text dialog. To turn the label of, deselect the Display
checkbox in the label section of the dialog. Change the flux section points directly in the Points section.

Time Settings
Two different time intervals can be set for reporting the flow over the flux section. Provide a Start,
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Incrementl, and End1 time. The second interval will continue from the End1 time to the End2 time at the
Increment2 interval. The second interval is optional.

Report Option
This option is used to indicate if a report that summarizes the flux across the flux section will be generated
by the solver.

History Graph Option
This option is used to indicate if a history graph of the flux across the flux section will be generated by the
solver.

Write To File Option
This option is used to indicate if the history graph data generated by the solver will be written to a text
file.

Advanced Flux Section History Plots
Press the Advanced Flux Section History Plots button to open the Advanced Flux Section History Plots
dialog.

Output Options

If PLOT is selected the flux section output will be displayed while the solver is running and remain open
when the solution is obtained. It will also be stored in the .PG4 file generated by the solver. If MONITOR
is selected the plot will be available while the problem is running, but not after the run is completed and it
will not be written to the .PG5 file.

9.2.8.3.4 Surface Flux Sections

Below is the second tab on the Flux Sections dialog. It is only available in 3D analysis.

Adding Flux Sections
Use the New button to add new entries to the list. Select the Surface from the drop-down.

Deleting Flux Sections
Select a Flux Section from the list and press Delete to remove it from the problem.

Restrict Report to Region
Surface flux sections report the flux through all regions by default. To report only for a specific region
choose it from the drop-down.

Time Setting

The mass flux is reported at a specified time interval and history plots of the various flux section
components can be chosen. Two different time intervals can be set for reporting the flow over the flux
section. Provide a Start, Incrementl, and End1 time. The second interval will continue from the End1 time
to the End2 time at the Increment2 interval. The second interval is optional.

Use the Set All Times button to open the Set All Problem Flux Section Times dialog.

Report Option
This option is used to indicate if a report that summarizes the flux across the flux section will be generated
by the solver.

History Graph Option
This option is used to indicate if a history graph of the flux across the flux section will be generated by the
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solver.

e Advanced Flux Section History Plots
Press the Advanced Flux Section History Plots button to open the Advanced Flux Section History Plots
dialog.

e Output Options
If PLOT is selected the flux section output will be displayed while the solver is running and remain open
when the solution is obtained. It will also be stored in the .PG4 file generated by the solver. If MONITOR
is selected the plot will be available while the problem is running, but not after the run is completed and it
will not be written to the .PG4 file.

e Coordinate System
Surface flux sections are reported in the same coordinate system in which 3D geometry is defined. Positive
x flux is mass flux in the direction of increasing x values (to the right). Positive y flux is mass flux in the
direction of increasing y values. Positive z flux is mass flux in the direction of increasing z values (up).

9.2.8.3.5 Set All Problem Flux Section Times Dialog

The Set All Problem Flux Section Times dialog is applicable to both Extruded Flux Sections and Surface Flux
Sections in a 3D analysis. Enter new time values and click OK to update all the flux section times for the
problem for either the extruded or surface flux sections.

9.2.8.3.6 Advanced Flux Section History Plots Dialog

All the components of flow are listed. Select which components to generate history plots for.

Generate History Text File
Choose to generate an ASCII history plot text file for individual components. The file is written to the
solution files directory with this format: Component_FluxSectionNumber.tbl.

The History Text File is useful for importing the data into spreadsheet applications
for data manipulation, compilation, and plotting of multiple variables on the same
Tip! chart

9.2.8.3.7 Boundary Flux

The flux across a boundary can be reported or graphed by using the Boundary Flux dialog. The flux can be
reported for any boundary that a boundary name has been defined for. See the Region Properties section for
defining boundary names.

Select Model > Boundary Flux from the menu to open the Boundary Flux dialog.

e Report Option
This option is used to indicate if a report that summarizes the flux across the boundary will be generated
by the solver. Select boundaries from the list and then press the Yes button to include a report. Press No to
not have the selected boundary fluxes reported.

e History Graph Option
This option is used to indicate if a history graph of the flux across the boundary will be generated by the
solver. Select boundaries from the list and then press the Yes button to include a history graph. Press No
to not have the selected boundary fluxes graphed.
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e Write To File Option
This option is used to indicate if the history graph data generated by the solver will be written to a text file.
Select boundaries from the list and then press the Yes button to write to file. Press No to not have the
selected boundary fluxes written to file. Note that the History Graph option must be set to Yes in order to
use the Write To File option.

e Time Settings
Provide the time settings for when the selected boundary fluxes will be reported and graphed. Press the
desired Update button to update the list.

9.2.8.3.8 Flux Section Coordinate System
The following sections outline the system by which flux section values are reported.

9.2.8.3.8.1 Boundary Flux Integrals

The movement of fluid across a boundary may be calculated through a boundary flux integral. Each region
boundary in CHEMFLUX is given a name. The user may identify subsections of a particular region by
assigning a name to certain line segments in the Region Properties dialog.

Normal Flux: Positive flow is into a region when reporting the flux normal to a region boundary. This
applies to boundaries that are external or internal to a model. Normal flux therefore reports the total net flux
into or out of a region.

X, Y, and Z Flux: Positive flux values are always taken as flow in the direction of the positive global
coordinate. For example a positive reported flow in the x-direction would indicate flow to the right. Positive
flow in the y-direction would indicate flow up. This convention is maintained regardless of the direction in
which a region is drawn.

9.2.8.3.8.2 Flux Section Integrals

Proper calculation of flow across flux sections is critical for determining mass-balance of a problem. A 2D
flux section defines a 2D line segment through which the flow will be calculated. A 3D flux section defines a
vertical plane through which the flow will be calculated. The following convention is adopted when reporting
flux section flows.

Normal Flux: There are 4 cases to consider when evaluating the flux normal to a flux section.

1. External Region Boundary:
If the flux section has been drawn on a region boundary that is external (on the outside) of the
model then positive flow will be into the region.

2. Internal Region Boundary — Region Given:
If the flux section has been drawn on a region boundary that is internal (on the inside) of the
model and a region has been specified using the “Restrict to Region” option then positive flow
will be into the region specified.

3. Internal Region Boundary — Region Not Given:
If the flux section has been drawn on a region boundary that is internal (on the inside) of the
model and a region has not been specified using the “Restrict to Region” option then positive flow
will be into the first applicable region.

2D: The first applicable region will be determined by the region hierarchy with Region 1 being
HIGHEST. Therefore, the first region in ASCENDING order that the flux section is drawn over
will be the first applicable region.
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3D: The first applicable region will be determined by the region hierarchy with Region 1 being
LOWEST. Therefore, the first region in DESCENDING order that the flux section is drawn over
will be the first applicable region.

4. Internal to a Region:
If the flux section has been drawn internal to a region then the Left Hand Rule will be applied. The
Left Hand Rule means that if an “L-Shape” is made on the left hand with the index finger and
thumb and the left hand index finger is pointed in the same direction as the flux section arrow,
then positive flow through the flux section will be in the direction that the thumb is pointing.

*Note that a flux section must be specified as Internal on the Flux Section Properties dialog
otherwise it will be assumed to be on a region boundary.

Normal flux reports the total net flux into or out of a region.

X, Y, and Z Flux: Positive flux values are always taken as flow in the direction of the positive global
coordinate. For example a positive reported flow in the x-direction would indicate flow to the right. Positive
flow in the y-direction would indicate flow up. This convention is maintained regardless of the direction in
which a region is drawn (i.e., clockwise or counter-clockwise).

9.2.8.3.8.3 Surface Flux Integrals

The movement of fluid across a surface may be calculated through a surface flux integral. The following
convention is adopted when reporting surface flux section flows.

Normal Flux: There are 2 cases to consider when evaluating the flux normal to a surface.

1. External Surface:
If the top or bottom surface is being considered then positive flow will be into the model.

2. Internal Surface:
If the surface is internal to the problem then positive flux values are as flow into the layer above
the specified surface.

Normal flux reports the total net flux into or out of a region.

X, Y, and Z Flux: Positive flux values are always taken as flow in the direction of the positive global
coordinate. For example a positive reported flow in the x-direction would indicate flow to the right. Positive
flow in the z-direction would indicate vertical flow up. This convention is maintained regardless of the
direction in which a region is drawn (i.e., clockwise or counter-clockwise).

9.3 Draw Menu

The purpose of the Draw menu is to present the options by which the user can draw objects on the CAD
workspace. The various objects are listed in the menu system. The following topics provide a brief overview
of the drawing of the various objects. A full description of the properties of each object may be found under
the help for the object dialog.
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9.3.1 Artwork

The Draw > Artwork menu allows the drawing of lines, text, as well as allowing bitmaps to be inserted into
the drawing space. These commands convert the user to the drawing mode and allow drawing of the specific
object. The shape of the cursor will change to signify the drawing mode. The user can cancel the drawing
mode and go back to the select mode by pressing the Select icon on the toolbar or proceeding to View > Select
in the menu system. Art Objects are drawn on the region displayed in the region selector. They are for
visualization purposes and do not affect the model solution. If the region the objects are on is deleted they will
be deleted also.

All artwork geometry does not affect the model outcome and is for illustrative purposes only. Lines may
include an arrow at either or both ends. The properties of a line or text object may be edited by double-
clicking on that object. It should be noted that artwork is located using only X, y coordinates. This means that
when artwork is placed on a 3D image it is not located in 3D space and will not rotate with the model.

9.3.1.1 Draw Text
Use the following steps to add text to a model.

1. Select the Draw > Artwork > Text button from the menu.

2. The cursor will turn into a cross hair. Click the insertion point in the drawing space with the
mouse.

3. The Format Text dialog will appear.

4. Enter the text in the space provided and select the desired properties for your text.

5. Click OK and the text is added to the model.

Textbox properties include a border, fill, various font settings and orientations. Set
the World Coordinate System location for the center of the textbox by specifying the
Tip! coordinates.

Double-click on any textbox in the workspace to bring up the dialog to change the properties or define a new
location for the textbox. Setting a property to automatic will reset to the defaults. A custom setting indicates
that the properties are different from the defaults.

9.3.1.2 Draw Line Art

Line art can be drawn for any model. Line art does not change the geometry of a model and will not be added
to any plots. To enter line art, click on the Line Art button and draw in the line. Double-click the last point to
finish the line.

9.3.1.3 Insert Image

To insert an image to the model workspace, select Draw > Artwork > Insert Image. A window will pop up,
prompting the user to Browse for the desired image file that is to be placed. Once the image is placed, it can be
dragged anywhere on the workspace.

9.3.2 Model Geometry

The drawing of model geometry menu options allow the drawing of model objects which do affect the
modeling outcome. The basic drawing objects for model creation include closed polygons and circles. There is
generally no limit on the number of shapes or circles that could be potentially used to create a numerical
model. The primary limitation is the practicality of the created model.

One or more shapes may be placed on a model Region. If there are multiple shapes on a region then the user
must specify which is the dominant shape. Once the dominant shape is specified, then the remaining shapes on
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a region either become cut-outs (if they are within the dominant region) or they become additional separately-
gridded shapes (if they are outside the dominant region).

The user should note that only one soil may be applied to each region. So if multiple shapes are defined in the
same region then they will all have the same material properties. It is recommended that each Region contain
only one shape.

Drawing of features allows the user to i) force node points along a certain internal line(s) as well as ii) specify
internal boundary conditions which are applied to a feature.

9.3.3 Initial Water Table

This menu item allows the user to graphically draw the water table on a 2D model. Initial head is then
calculated to be hydrostatic from these initial conditions. Once the user selects this option the cursor will
convert to drawing mode and the user may specify the location of the water table as defined by a polyline. It
should be noted that for this option to be enabled the user must specify on the initial conditions dialog that
they will be drawing a water table.

Drawn water tables should be internal to the regions of a model.

Water Table data can be viewed and edited on the Initial Water Table dialog.

9.3.4 Flux Sections

Flux sections are lines created internal to regions on which the water flux across these lines is integrated
(summed). A flux section is highly useful for performing a water balance on a numerical model. Flux sections
are typically placed across the entry and exit points.

Selecting Draw > Flux Sections will move the user to draw mode and allow drawing of a flux section. The
endpoint of flux sections should always be placed on a region node point. Flux section end points which are
located near a region boundary line segment may cause meshing errors if they do not end *exactly* on the line
segment midpoint.

9.4 Edit Menu

The edit menu implements standard Microsoft Windows editing functions such as the delete, undo, and redo
functions. These functions are implemented in a manner consistent with established Windows standards.

Delete: The Delete function deletes the object currently selected in the CAD window. The
deleted object is then moved to a temporary file on the hard disk such that the
deleted object can be recovered through the use of the Undo function.

Undo: The Undo function reverses the changes made with the last primary command.
This command could be applied to undo the deletion or addition of an object
added to the CAD window. It could also be applied to reverse the changes made
in the last-edited dialog.

It should be noted that a list of all model changes for a particular session are
stored in temporary files in the current model directory. Multiple Undo commands
will continue to reverse the changes made to the current model in the order they
were implemented.

The Undo feature by default is disabled when a 3D model is loaded in the
AcuMesh software because of the added time required to store changes when
editing large models. The Undo feature can be enabled for large models in
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AcuMesh through the Options > Settings dialog in the SVOffice Manager dialog.

Redo: The Redo command reverses the changes made with the last Undo command. For
example, if the user adds a feature to a model and then presses Undo, the object
will be removed. Pressing Redo will bring the object back.

9.5 Format Menu

Formatting options related to viewing data in the CAD window are contained in the Format menu. The
functions contained in this menu do not change the model solution. A particular emphasis was placed on
adding functions to this menu which allowed reasonable views of the data in the context of the current
coordinate system. In a 1D or 2D model, or a 2D plan view of a 3D model, there will appear two sets of axis
indicating the coordinates for the current system. Descriptions of the methods used to place the current model
in space are described in detail in the following sections.

95.1 Format Axis

The axes are by default displayed at the edge of the currently specified world coordinate system. These axes
are displayed inside the current CAD window and, as such, are included on any exported visualization of the
CAD window. Full control over the details such as the axis labels, the axis title, the tic mark locations, the
spacing of the labels and other details can be found under the Format > Axis dialog. The dialog is detailed and
allows detailed control over how the axis are visualized. Control of the details of the axes are valuable for the
production of professional report-ready graphics.

The following specific axis functions should be noted.

Choose the Axis to Format: In this option group, the user can select the axis to edit. All data below this
option group are updated immediately upon selection. The user also has the option to hide the current axis.

Remaining controls on the dialog may be edited through the use of the following tabs:

Patterns The purpose of this tab is primarily to allow control over the look of the line and

Tab: tic marks representing the axis. Under the X Axis Line group box the style of the
line can be set to None (no line), Auto (default), or Custom (allows the user to
specify custom settings). If Custom is selected then the user can specify the style,
color and weight of the axis line.

Option boxes on the right hand side of this page of the dialog allow the user to set
the display of major and minor tic marks as well as the location of the tic mark
labels.

Scale Tab:  The scale tab operates in a manner similar to its operation in Excel®. The
maximum and minimum values of the current axis, as well as the crossing point
for the opposite axis, can be specified. The major division setting controls the
number of divisions between the specified minimum and maximum values. The
minor division setting controls how many tic marks will be placed within each
major division.

Numbers The formatting of the labels associated with each major tic mark can be

Tab: accomplished using this tab. The category list box displays the major categories
of number formatting. Specific settings such as the number of decimal points and
the font used for the labels can be designated.

Title Tab: The settings on the title tab allow the text as well as the formatting of the text for
the axis titles to be adjusted. The font can be specified using the
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Windows-standard font selection dialog. A bounding box can also be placed
around the text using options under the Title Text Box option group.

95.2 Format 3D Orientation Axis

The 3D orientation axis is, by default, located in the upper left corner of the CAD window when 3D models
are viewed in 3D mode. The intent of the small axis is to provide an indication of the orientation of the
coordinate system. Specific settings of the orientation axis which may be adjusted can be found under the
Format > 3D Orientation Axis dialog box.

Show 3D Orientation Axis: This check box allows the user to turn off and on the display of the
orientation axis.

Label Font: The font button allows the user to adjust the font used to display the "X", "Y", and "Z"
letters on the axis of the graphic.

Size: Controls the size of the orientation axis. The size is set in percent of total vertical CAD window
height.

Position: The position of the center of the orientation axis. Specified in percentages in the x and y
directions.

Axis Line Stroke: This group box allows the user to set the color and weight of the orientation axis
lines.

95.3 Format Rulers

Rulers are displayed along the edge of the CAD window. The Rulers are not included in any export of the
CAD window and are provided as a drawing aid only. Full control over details such as ruler labels, tic mark
style, spacing of the labels, and other details can be found under the Format > Rulers dialog.

The following specific ruler functions should be noted.

Choose the Ruler to Format: In this option group the user can select the ruler to edit. All data below this
option group is updated immediately upon selection. The user also has the option to hide the current ruler.

Remaining controls on the dialog can be edited through the use of the following tabs:

Patterns The purpose of this tab is primarily to allow control over the look of the line and
Tab: tic marks represented by the ruler. Under the Horizontal Ruler Line group box,
the style of the line can be set as well as the color and weight of the line.

Option boxes on the right hand side of this page of the dialog allow the user to set
the display of major and minor tic marks and the weight of the lines used to
represent the tic marks.

The Minor Division sets the number of displayed tic marks between each label.

Numbers The formatting of the labels associated with each major tic mark can be

Tab: accomplished using this tab. The category list box displays the major categories
for number formatting. Specific settings such as the number of decimal points and
the font used for the labels can be designated.
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9.6 View Menu

CHEMFLUX provides advanced functionality to allow the user to view the numerical model in a variety of
ways. Many of the view commands can also be accessed from the View toolbar. New to SVOffice 2006 is the
ability to view a 3D numerical model in 3D mode prior to obtaining a solution.

K None of the settings on the view menu affect the output of the numerical model.
Tip!
The various selections on the view menu can be detailed as follows:

Select: The select function switches the cursor to the standard select mode. Objects can be
selected for making changes.

Double-clicking on most objects will bring up the object properties. Clicking
the right mouse button on most objects will bring up a context-sensitive menu
Tip ! whichwill list available commands relevant to that object.

Artwork: This menu item allows the display of artwork to be turned on or off. Artwork does not
affect model results in any way but is provided for display purposes only. Turning off the
display of artwork does not delete any artwork from the system but simply makes the
artwork invisible. Turning on artwork will re-display existing artwork.

Pan: The panning function allows the translation of the CAD viewing window within the world
coordinate system. Selecting the pan function switches the cursor to a small hand icon
which will allow dragging of the model "paper" workspace.

Zoom: The zoom function allows current view of the model design to be magnified or expanded.
Typically the zoom function is useful zooming in on a model that has been drawn smaller.

Holding down the Shift key while pressing the zoom in/out toolbar button will
cause the current model to be zoomed out. By default pressing the zoom
Tip! toolbar button will always zoom in.

Rotate: The rotate functions are only applicable to 3D model viewing when in 3D viewing mode.
These functions allow a 3D model to be rotated around one of the coordinate axis.

A free-form rotate functionality is also provided in order to allow numerical models to be
rotated in any direction based on the movement of the mouse cursor.

Lighting: The lighting function determines whether the effects of lighting from a single arbitrary
light source are applied to the visualization of a 3D model. This function is only
applicable when viewing a 3D model in 3D mode. Turning off lighting will remove the
advanced shading of surface polygons.

Translucency: The translucency function controls the way 3D model surfaces and sidewalls are
displayed. If translucency is turned on, the surfaces and sidewalls are displayed as being
translucent. In other words, the user will be able to see through the surfaces and sidewalls.
If translucency is turned off, then all sidewalls and surfaces are displayed as a solid color.
Turning translucency on is useful when viewing the inner workings of a complex 3D
numerical model.
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Translucency is only applicable to 3D numerical models which are viewed in 3D mode.

Toolbars: The use of floating toolbars is a feature added in the release of SVOffice 2006. The
toolbars allow program operations often used by the user to be summarized in logical
"groups" of common functionality. Use of the View > Toolbars menu option allows the
various toolbar groups to be turned off or on.

It should be noted that toolbar buttons are also turned off or on depending on the currently
loaded numerical model. For example, all toolbar buttons with 3D functionality are turned
off (greyed out) when a 2D numerical model is loaded.

Turning off certain toolbars in some instances can be useful in reducing the clutter on the
display.

9.6.1 Settings

The View Settings dialog is the central dialog for changing the settings of the view coordinate system or the
drawing space, and the aspect ratio used to display the current model. Setting the size of the coordinate system
is one of the first steps the user would likely do when a model is first created. The specifics of each area of the
View Settings dialog may be seen in the following sections. It should be noted that the look of the form and
the setting contained therein change on this dialog depending if the user is working on a 2D or a 3D model.

2D Model
In a 2D model there is defined both a World Coordinate System (WCS) which is generally the extents of
the numerical model in real-world coordinates, and View Coordinates which are the coordinates of the
current CAD window.

View Coordinate System: The View Coordinate System (VVCS) represents the range of coordinates
displayed in the current CAD window.

Constrain Proportions: This setting locks the proportions of the view coordinate system so that they
cannot be adjusted if the CAD window is re-sized. If Constrain Proportions is not checked then the current
model will be stretched or compressed each time the CAD window is re-sized.

Drawing Space in Pixels: This group box contains the physical settings of the current drawing space
or CAD window.

Aspect Ratio: Contains the ratio of coordinate lengths in the x : y directions. For example, specifying an
aspect ratio of 1:2 will mean that each y unit length will be twice as long as each x unit length.

3D Model - 3D View
In 3D model view the extents of the world coordinate system are always taken to be the maximum and
minimums as defined by the region and surface geometry. Most of the settings on the 3D View Settings
dialog relate to the manner in which the 3D model is represented.

Projection: Controls whether an orthographic or perspective correction is introduced into generating the
3D view of the numerical model design.

Aspect Ratios: Ratios between the various coordinate axis may be defined by these entries. For
example, if the user wants to exaggerate the z scale by 5 times they can enter 5.0 beside the z text box and
then click on the XY dependant radio button. This sets the z coordinate to be exaggerated by 5x and sets
the exaggeration dependant on the combined x and y scales.

Apply: Pressing the apply button applies all the current view settings to the currently displayed model.
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3D Model - 2D View

A 3D model is always displayed in plan view when 2D display mode is selected. In plan view the View
Settings dialog reverts back to the same dialog used in a regular 2D model. The settings are identical in
operation and how they are applied to the current 2D plan view of the 3D numerical model.

9.6.2 Options

The View > Options dialog contains general options related to the grid used in model design, drawing modes,
and certain global formatting settings.

Grid Tab
The options on this tab primarily control the options for the Status Bar. The current horizontal and vertical
grid spacing options can also be specified. Grid spacing is always assumed to start from the origin of 0,0.
A description of commands is as follows:

Mouse The coordinates of the current location of the mouse in the drawing space
Coordinates: are located at the left of the status bar.

Aspect Ratio: Indicates the aspect ratio at which the problem is being viewed.

Grid On/Off: The GRID control turns the Workspace grid on or off in the drawing

space. Bold text indicates this control is on. If it is displayed a point will
be plotted at each grid intersection point. When the grid is off, the Snap
control is not in effect. Select the View > Grid Spacing button to open the
Grid Spacing dialog, which allows you to specify the spacing between
grid points in the drawing space. The grid is used to provide the user with
coordinate locations at regular intervals. For example, the user may want
to see grid points plotted every half meter in the x-direction or every 1
meter in the y-direction in order to simplify the drawing of geometry. The
grid spacing can be set under the View > Options dialog on the Grid tab.

If the user-defined grid space is too dense (less than 5 pixels after
converted into screen coordinates), the grid points will not be displayed.
If the canvas is Zoomed In, as soon as the grid spacing > 5 pixels, the grid
points will be shown automatically.

Snap On/Off: When an object is being drawn, the lines or points will snap to the grid
point nearest the mouse cursor. Bold text indicates this control is on. If
snapping is turned on then any point drawn using the mouse in the CAD
control will snap to the nearest grid point. Snapping applies to all drawn
geometry including regions, features, flux sections, and artwork.

OSnap On/Off: If the OSnap control is turned on and your cursor is placed on a region,
clicking the right mouse button will cause the cursor to snap to the
nearest region point. Bold text indicates this control is on. Object
snapping allows snapping to the line end-points of other objects already
drawn in the CAD control. Use of this setting is recommended when
drawing regions which touch each other or drawing flux sections which
must start or end at a region boundary.

Ortho On/Off: The Ortho control will restrict lines in the drawing space to be drawn at
angles of 0 or 90 degrees. Bold text indicates this control is on.

Sticky On/Off: The Sticky setting will cause adjacent region node points to move
together when adjacent points are moved. For example, if two regions
represented by boxes are side-by-side and share two node points, moving
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the one region will cause the node in contact with this region to be moved

along with it.
Sizing The CHEMFLUX allows you to size the Workspace - drawing space such that
Drawing Space: the maximum area is available. The size of the drawing space can be

adjusted by dragging the lower right corner of the drawing space.

Format Tab
The Format tab contains options regarding the method by which boundary conditions and region node
points are displayed in the CAD window.

Boundary This group box contains options regarding whether or not to display
Condition boundary conditions graphics. Symbols and colored line segments are
Graphics: used to represent the various types of boundary conditions. These

symbols and their meaning is defined in the Boundary Conditions
section of the user's manual.

The size of the displayed boundary condition symbols is determined by
the B.C. Graphics Scale text box as specified in percent of the total x
distance of the world coordinate system.

Node Dimension: Turning on node dimensioning displays the x and y coordinate of each
region node point when viewing a model in 2D mode. The font used for
this dimensioning can be selected. The default for this feature is off.

Node Symbol: The symbols used to represent node points can be selected in this group
box as well as the color and the weight of the lines.

9.6.3 World Coordinate System

The World Coordinate System (WCS) represents the range of coordinates in the current model that will be
considered active in model description. Typically WCS boundaries should be selected that are at least 10%
larger than the maximum and minimums of the selected model geometry. All finite element software codes are
designed to function correctly in all four quadrants therefore model solution should be independent of the
quadrant in which it is drawn.

9.6.4 Elevation Contours

Surface elevation contour settings can be changed by accessing the View > Elevation Contours menu. The
menu item will open the Surface Contour Settings dialog. Contouring of surface elevations is currently only
enabled when the user is using the 2D plan view of a 3D numerical model.

9.7 Solve Menu

The Solve menu options control all commands relating to i) writing a mathematical script describing the
created model and ii) calling the FlexPDE solver to initiate solving the model. Special versions of the
mathematical scripts may be written out to the solver in 3D problems in order to obtain a better visualization
of the model solution prior to trying to solve.

9.7.1 Analyze

The CHEMFLUX solver performs analysis of the problem. Once a problem has been defined click the
Analyze button or select Solve > Analyze from the menu. CHEMFLUX will write a descriptor file that is
interpreted by the solver and solving will begin. If the problem definition is incomplete the solver may not run
and error messages will be displayed.
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The descriptor file is open to modification by the end user. This allows for the possibility of problem
customization and is ideal for the researching of alternate formulations by Universities. It should be noted,
however, that the formulations implemented by SoilVision Systems Ltd. have been aggressively benchmarked.
If the user changes the formulation SoilVision Systems Ltd. does not endorse any results obtained.

9.7.1.1 Solver

The CHEMFLUX solver uses a Galerkin Integral method with a non-linear Newton-Raphson Iteration
technique with pre-conditioning of the convergence matrix, to solve the partial differential equations
describing the flow of water through soil. When the problem is analyzed from the CHEMFLUX Workspace, a
descriptor file is written and sent to the solver.

9.7.1.1.1 Solver Menu

You are provided with several functions from the menu located at the top of the descriptor file. If you wish to
just begin solving the problem choose Run.

e File
Contains standard New, Open, Save, etc. operations.

e Edit
This item selects the standard text editing functions.

e Domain
Display a preview of domain boundaries without attempting grid generation. From the domain display,
you can invoke RUN, or return to the editor.

e Run
Begin execution of the displayed descriptor. This function does not automatically save the descriptor,
since you may be intending to change the name. Instead, the descriptor is saved in the temporary file
"run_temp.pde" in the current folder. If disaster should occur, the modified file can be restored from this
temporary. See While the Problem Runs for a description of the reports in the Status Window.

e Stop
The analysis may be stopped at any time by using this option

¢ Modify
Select Modify to view the descriptor file for the problem. Modifications can be made to the descriptor file
and the problem re-run. An example of a typical descriptor file has been provided in Appendix A.

e Plots
Select this option to view the plots for the problem. See Solver Plotting.

e Help
View the Solver Help file.

9.7.1.1.2 Status Window

On the left is the "Status" window, which presents an active report of the state of the problem execution and a
small view of the current computational grid. The format of the printed data will depend upon the kind of
problem, but the common features will be:

The elapsed CPU time
The number of computation Nodes
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The number of Finite Element Cells

The number of Degrees of Freedom (nodes times variables)
The amount of memory allocated for working storage

The current estimate of RMS spatial error

Other items, which may appear, are

The stage number

The RMS Solution error for the most recent iteration
The iteration count

The convergence status of the current iteration

A report of the current activity

o Adaptive Refinement
Once the initial mesh is constructed, FlexPDE will continue to estimate the solution error, and will refine
the mesh as necessary to meet the target accuracy. In time dependent problems, an adaptive refinement
process will also be applied to the initial values of the variables, to refine the mesh where the variables
undergo rapid change. Whereas cells created by this adaptive refinement process can later be re-merged,
cells created by the initial explicit density controls are permanent, and cannot be un-refined.

9.7.1.1.3 Solver Plotting

On the right side of the screen are separate windows for each of the PLOTS requested within the Plots Dialog.
The PLOTS will be sent to the ".PGX" graphic record, in the Default directory for the current problem.

Click the right mouse button on any plot window to bring up its menu. The menu items are:

e Maximize
Will maximize the plot window so it is the only one viewed

e Restore
Will restore the plot window to its original size and display all the plot windows

e Print
Sends the window to the printer using a standard Print dialog.

e Export
Invokes a submenu that allows the selection of a file format for exporting the plot.

¢ Rotate
Certain plots that display data in three dimensions can be rotated.

9.7.1.2 Run Logs

A run log file is generated by the solver for each run that contains information on the run including solution
time, time steps or stages, nodes and other things. The file is called ProjectID_ProblemID.log.

After the problem is sent to the solver the Run Log dialog will open. Once the solver has finished, close the
solver and then press the Read File button to load the log file information into the dialog. If the solver runs for
a long period of time of uses small time steps, the size of the log file may become large. Use the Stop button to
cancel reading the run log. A comments section is provided where notes specific to the run can be recorded.
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9.7.1.2.1 Run Log Summary Dialog

The Run Log Summary dialog displays a list of the runs that have been completed for the problem. Access the
dialog from Solve > Run Log Summary. The Log Read field will indicate whether or not the log file was read
and loaded. If the log was not read the Solved column will indicate No and no solver time will be displayed
regardless of whether the problem actually solved or not.

Press the Run Log button or select a run from the list to open up the more detailed Run Log dialog.
9.7.1.3 Viewing Results

After the CHEMFLUX solver has analyzed a problem select Solve > View Results... to view the solver output
plots without having to re-analyze the problem. The plot results are stored in the .pg5 file generated by the
solver.

9.7.2 Write Solver File

This command initiates writing out of the PDE mathematical descriptor file but does not initiate execution of
the file. This command is often useful if the user wants to examine the mathematical script file prior to
execution. It may also be useful in queuing up a large number of models and then waiting until they are all
properly set up until models are executed manually by the user.

9.7.3 Preview

Preview is a 3D function which allows various aspects of a 3D numerical model to be examined without
initiating solution of the model. The functions primarily initiate meshing of the 3D model and show contours
of the elevations of the various surfaces as they intersect regions. It is recommended that the Preview functions
be used in the creation of all 3D models in order to validate the proper model set up.

It should be noted that there may be slight differences between the way a model is visualized in the front-end
and the manner in which the finite element interprets the model. This is primarily due to the fact that the finite
element solver first meshes the model. During the meshing process there is some "interpretation™ of the
surfaces and regions presented to the solver by the front-end. This "interpretation” is usually insignificant but
it is recommended that the user use the preview functions to check the final meshed model prior to solution.

Surfaces: With this command a script is written to the FlexPDE solver which primarily focuses
on creating a set of plots which contour the elevations of each surface.

Regions: This preview script writes out a detailed script such that the volume and area of each
region may be determined.

Layers: This preview script writes out equations and generates plots such that the thickness of
each surface can be determined.

9.8 Results Menu

CHEMFLUX provides advanced functionality that allows the user various options in order to view model
output in a number of different ways. In particular, model output related to the FlexPDE plots created during
model solution can be viewed, or the results exported to a .DAT file can be viewed using the AcuMesh
software.

AcuMesh:  The AcuMesh command calls activates the AcuMesh back-end visualization
software module. A dialog will appear asking the user which .DAT file to open in
the current model directory. A .DAT file must first be specified in the Model >
Reporting > Output Manager in order for this option to be available for the end
user. Please refer to the AcuMesh user's manual for full details on the operation of
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Verification

FlexPDE
Plots:

Node
History:

the AcuMesh visualization software.

When the FlexPDE solver is called using the Analyze function, all output which
has been designated type PLOT and which have been selected by the user in the
Model > Reporting > Plot Manager dialog is saved to a .PG5 file in the current
modeling directory. This function calls the FlexPDE solver in viewing mode and
opens the .PG5 file in the current modeling directory. It should be noted that
MONITORS are not saved in the .PG5 file.

Verification is a necessary part of any modeling exercise. This menu contains the
functions that can be used for verification and validation of the current numerical
model.

Plots of the total number of nodes in a problem as a function of time or stage can
be obtained using this function. It is often interesting to view the mode history in
a transient problem. If, for example, a numerical model is being subjected to
excitations at various time-steps this may be reflected in increased node density. It
should be noted that it is easier for the solver to justify creating nodes than
releasing them through a relaxation. Therefore, created nodes may remain even if
the original excitation which caused the introduction of the modes disappears.

The Results menu also provides QA/QC functionality for exploring the quality of the obtained solution. View
the following sections for further details.

9.9

better solution. This functionality of switching between the various components is provided in the Window

Window Menu

Part of the new integrated design of SVOffice includes the ability to switch back and forth between the various
component software packages. For example, if the user is solving a slope stability model using SVDYNAMIC,
they may want to go to SVSOLID to change the stress model and then go back to SVDYNAMIC to obtain a

menu as well as the Application Selector toolbar.

9.10 Help Menu

The help menu of our software provides links to resources which will aid in successful model creation. The

help menu for each software package brings up help related to the particular software at hand. Help in creating
and opening numerical models can be found in the help menu of the SVOffice Manager dialog.



SOILVISION SYSTEMS, LTD. Other Topics 102 of 108

10  Other Topics

Other topics related to numerical modeling are covered in this section.

10.1 Model Verification

Verification of model results is an essential part of of the modeling process. The purpose of model verification
processes is to answer the question "How do we know if model results are good?" Unfortunately there is not a
singular answer to this question but there are a number of checks which can greatly increase the chances of
catching models with which there are problems.

Error Limit

The primary controls over the spatial and temporal errors in the FlexPDE solver are the ERRLIM and
TERRLIM variables located in the FEM Options dialog. A first modeling step involves successively reducing
these error limit controls until the model solution does not change. Unfortunately this is a crude technique and
not well-suited to the solution of large or difficult models.

Water Balance Checks

SVFlux implements flux sections which are integrals of the volume of water which passes a designated portion
of the problem. There are also plots available in the Plot Manager which allow the user to integrate the total
amount of water in the model at any given time. This integral of water volume may be summarized by model
region or as a total for the entire model.

It is recommended that the user make use of these reporting tools in order to check the validity of the
following minimization function.

Water In - Water Out = Change in water storage
If we re-arrange the above equation it becomes:
Water In - Water Out - Change in water storage = Residual

In a perfect world the residual would be zero. In a numerical model the Residual will not be zero. The water
balance error (Error) may then be calculated as:

Error (%) = Residual / Water In x 100

Soil Property Checks

A method of checking model results against original soil properties was suggested by Aubertin (????). This
method is of primary use when modeling the behavior of unsaturated soils. The method is designed to test the
ability of the finite element (or finite difference) solver to correctly follow the non-linear soil properties
associated with unsaturated soils. In this method the soil-water characteristic curve and the unsaturated
hydraulic conductivity curve are plotted for a specific region. Then the suction and volumetric water content
values are pulled from the finite element mesh for each point in that region and plotted on the same graph. If
the analysis has been solved correctly, the finite element nodal points will plot directly over top of the line
representing the unsaturated soil properties.

This feature may be initiated under the Output > Verification > Soil Properties menu item.
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10.2 Expressions

Our finite element products offer the unique benefit in that an equation parser is built into the FlexPDE finite
element solver. This means that user-defined equations may be entered into the software at a variety of
locations which will then be interpreted by the software at run-time. Boundary conditions are a particular
application of this ability which is of particular use in common numerical models. The end user may want to
enter a boundary condition which is a function of position, time, or another model variable. Examples of this
may include:

o Tides: tidal movement in SVFIux can be represented as a head boundary condition which rises and lowers
according to time. A function can be built using the SIN trigometric function.

o Heap leach applied fluxes: The application of fluxes in a heap leach analysis may be represented by a
complex function which is fit to data. This function can then be entered into SVFlux as an applied flux.

o Traffic loads: Generalized traffic loads which vary over the coarse of a day can be applied as a complex
function based on time.

o Airtemperatures: Air temperatures which vary dramatically over a 24-hour period can be represented by a
mathematical function and applied as a boundary condition in SVHeat.

e Chemical applications: Varying chemical applications to a ground surface can be represented as a function
and entered as a boundary condition in ChemFlux.

The detailed framework in which these boundary conditions may be applied is described as follows. The
expressions outlined below may be entered in the front end in any text box in which the user is prompted for a
""constant/expression”.

EXAMPLES

Common examples of specific functions which may be accepted as boundary conditions are as follows.
Description Example

Constant 0.015

Function of spatial 28*x"3 - 64

variable

Function of model uw + 4.69

parameter

IF THEN ELSE if t <= 24 then -8.75E-06 * t + 2.4E-04 else O

Multiple IF THEN ELSE |If x <= 5 Then (39-y)*9.81 else

if x <= 29 and x > 5 Then (((-8.3E-02) * x +
(39.4))-y)*9.81 else

if x <=54 and x > 29 Then (((-0.32) * x +
(46.28))-y)*9.81 else

if x <= 73 and x > 54 Then (((-5.2E-02) * x +
(31.8))-y)*9.81 else

(28-y)*9.81

if x <=29 and x > 5 Then (((-8.3E-02) * x +
(39.4))-y)*9.81 else

if x <= 54 and x > 29 Then (((-0.32) * x +
(46.28))-y)*9.81 else

if x <= 73 and x > 54 Then (((-5.2E-02) * x +
(31.8))-y)*9.81 else

(28-y)*9.81

Nested IF THEN ELSE |if y > 30 then if x < 20 then 7 else if x < 50 then 6
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else 5 else
if x < 20 then 4 else if x < 50 then 3 else 2

if x < 20 then 4 else if x < 50 then 3 else 2

Solver Funct

ions

cos(t)"2 + In(x)

.TBL file references

6 + table("TableName.tbl")/1000

Contact/Jump -2*Jump[c]'2
COMMON VARIABLES
Variables which are commonly used in expressions are listed as follows.
Variable Description SVFlux| ChemFI|SVSolil SVHe [SVAIirFlo
ux d at W
X, Y,orZ |Spatial coordinates | TRUE | TRUE | TRUE|TRUE| TRUE
t Time TRUE | TRUE |FALSE]TRUE| TRUE
h Head TRUE | FALSE |FALSE] FALS| FALSE
E
u Pore-Water TRUE | FALSE |FALSE] FALS| FALSE
Pressure E
uw Pore-Water FALSE| FALSE | TRUE | FALS| FALSE
Pressure E
kx, ky, or kz [Hydraulic FALSE| FALSE |FALSE| FALS| FALSE
IConductivity E
C Concentration FALSE| TRUE |FALSE|FALS| FALSE
E
VX, vy, or vz |Gradient FALSE| TRUE |FALSE]|FALS| FALSE
E
e \Volumetric Water TRUE | TRUE |FALSE|JFALS| FALSE
Content E
Te [Temperature FALSE| FALSE |FALSE|JTRUE| FALSE
Kx, Ky, or  [Thermal FALSE| FALSE |FALSE|TRUE| FALSE
Kz IConductivity
u,v,orw [Displacement FALSE| FALSE | TRUE | FALS| FALSE
E
SX, Sy, Or sz [Stress FALSE| FALSE | TRUE | FALS| FALSE
E
E Young's Modulus FALSE| FALSE | TRUE | FALS| FALSE
E
nu Poisson's Ratio FALSE| FALSE | TRUE | FALS| FALSE
E
Sxy Shear Stress FALSE| FALSE | TRUE | FALS| FALSE
E
kax, kay, or |Air Coefficient of FALSE| FALSE |FALSE|FALS| TRUE
kaz Permeability E
SOLVER OPERATORS
Expressions may include mathematical operators from the following list.
Operator Comments
= Equal to
< Less than
>

Greater than

Less than or equal to
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>= Greater than or equal to
<> Not equal to

AND Both conditions true
OR Either condition true
NOT (Unary) Reverses

condition

SOLVER FUNCTIONS
The FlexPDE solver incorporates a number of pre-defined trigonometric functions. The supported functions

are shown below.

Function Comments

ABS(x) IAbsolute Value

ARCCOS(x)

ARCSIN(x)

ARCTAN(X)

ATAN2(y,X) IArctan(y/x)

BESSJ(order,x)|IBessel Function J

BESSY (order,x |Bessel Function Y

)

COS(x)

COSH(x)

ERF(x) Error Function

ERFC(x) Complimentaray Error Function

EXP(x)

EXPINT(x) Exponential Integral Ei(x) for real x>0

EXPINT(n,x) |Exponential Integral Ei(x) for n>=0, real
x>0

GAMMAF(x) JGamma Function for real x>0

GAMMAF(a,x) |Incomplete gamma function for real a>0,
x>0

LOG10(x) Base-10 logarithm

LN(x) Natural logarithm

SIN(x)

SINH(x)

SOQRT(x)

TAN(X)

TANH(X)
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11  Advanced Topics

The Advanced manual contains a description of more complex issues related to the solution of difficult
problems. The Advanced Manual may be found under the help menu of each respective software package.
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12 AcuMesh 2D / 3D Visualization

Select Output > AcuMesh from the menu to quickly open the AcuMesh visualization software once the solver
has completed a run.

AcuMesh DAT files are created using the Output Manager. Please see the Output Manager section for more
instructions on how to create AcuMesh files.
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